
 

Movavi Screen Capture Studio 3 for Mac
 

What do you need help with?
You can find useful information on any of following topics:

Removing trial restrictions
Activate Movavi Screen Capture Studio to use unlimited capture and save videos without a watermark

Recording screen
Capture any fragment of your screen or the full desktop.

Editing video
Create a movie from videos and photos

Capturing online video
Record video from online video

websites such as YouTube or Vimeo.

Creating a video tutorial
Record your screen and add annotations

Capturing Skype calls
Record Skype calls with sound from both ends.

Cutting video
Split video clips into parts

Recording only audio
Record any sound from a device or music on your computer.

Exporting videos
Save your finished movie

Using Screen Capture Using the Video Editor
 

Need more help?
Please mail us at support@movavi.com

 

mailto:support@movavi.com


 

 

Removing trial restrictions
When you first start your copy of Movavi Screen Capture Studio, it will be running in LIMITED TRIAL MODE. In trial mode,
you can try out all of the main features, but the following trial restrictions will apply:
 
TRIAL VERSION FULL VERSION

 Movavi Screen Capture Studio will stop working after 7
days

 Lifetime license

 A watermark with the words ' trial version' will be added to
all exported videos

 No annoying watermarks

 Capture time is limited to 2 minutes per video  Unlimited capture time
  Free updates
  Discounts on other Movavi products and upgrades
 
To upgrade to the full version, follow the instructions below to activate Movavi Screen Capture Studio:
 
Step 1: Buy activation key
1. Click the button below to go to the purchase page and click the Buy Now button there.
2. You will be taken to our web store. Fill in your billing information and payment options and proceed with the purchase
form. IMPORTANT! Be sure to enter a valid e-mail address: it will be used to deliver your activation key.
3. Once you have placed your order, you will shortly receive a confirmation for your order and an e-mail from
support@movavi.com containing your activation key.

Step 2: Open the activation window
1. Open the screen capture app or the video editor.
2. Open the application menu and select Activate Software. The activation window will open:

Step 3: Enter your activation key
1. Enter the activation key into the corresponding box.
2. Click Activate to complete the activation.

http://www.movavi.com/mac-screen-capture/buynow.html?asrc=scsm_help
http://www.movavi.com/mac-screen-capture/buynow.html?asrc=scsm_help


 

 

Having problems with activation?
If activation is not working as expected, try the following:

• Make sure that the activation key is entered correctly and is intended for the program you are activating.
• Try activating offline via e-mail.
• Contact us at support@movavi.com and we'll help you solve the problem!

 
Activating without Internet access
If the computer you have installed Movavi Screen Capture Studio on is not connected to the Internet, you can activate the
program via e-mail.
See detailed instructions

mailto:support@movavi.com


 

 

Getting an activation key
You can get an activation key either from our official website or from any of our partners in your region. Follow the steps
below to buy an activation key from the Movavi website:
 
Step 1: Go to the purchase page
To go the purchase page for Movavi Screen Capture Studio open the Help menu in Movavi Screen Capture Studio and
choose Buy Activation Key, or follow the link below...

Step 2: Choose a license type

•  If you plan to use Movavi Screen Capture Studio at home, click Buy Now on the purchase page to proceed with buying
the personal license.

•  If you plan to use Movavi Screen Capture Studio at work, in a government institution, or gain profit in any way, click
Business license on the purchase page.
 

After that, you will be redirected to an online store depending on your region and the available payment methods. All of our
vendor partners are secure and completely safe.
 
Step 3: Fill in your billing details
1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter a valid e-mail address. This e-mail will be used to deliver your activation key.
 
Step 4: Get your activation key
After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate
the program.
Activation instructions
Activating without Internet access
 
If you haven't received your activation key within the hour:

•  Check the Spam folder of your mailbox
•  Contact support

http://www.movavi.com/mac-screen-capture/buynow.html?asrc=scsm_help
http://www.movavi.com/mac-screen-capture/buynow.html?asrc=scsm_help
http://www.movavi.com/support/contact.html


 

 

Activating the Studio
Activating Movavi Screen Capture Studio will allow you to remove all of the trial restrictions and use the program forever.
 
You will need:

• Movavi Screen Capture Studio activation key. You should receive your key via e-mail right after your purchase is
completed. Don't have a key? Buy now

• Internet access. Don't have Internet access? See this guide on offline activation

 
Step 1: Open the activation window
1. Open the screen capture app or the video editor.
2. Open the application menu and select Activate Software. The activation window will open:

Step 2: Enter your activation key
1. Enter or paste your activation key into the corresponding box of the Activation window.
2. Click Activate to verify your activation key.
 

If you have entered the key correctly, you should see a message confirming successful activation.  Click OK to complete the
activation process and restart the program.

 
If online activation fails, try the following:

• Check that the activation key is entered correctly and is intended for the program you are activating.
• Try offline activation.

 
If you have any questions or problems while activating your Movavi software, please don't hesitate to contact our support
team.

http://www.movavi.com/mac-screen-capture/buynow.html?asrc=scsm_help
http://www.movavi.com/support/contact.html
http://www.movavi.com/support/contact.html


 

 

Activating without Internet access
Activating Movavi Screen Capture Studio will allow you to remove all of the trial restrictions and use the program forever. If
you don't have Internet access on your computer, you can use any other computer or mobile device to complete the steps
that require a connection.
 
You will need:

• Movavi Screen Capture Studio activation key. You should receive your key via e-mail right after your purchase is
completed. Don't have a key? Buy now

• A device or another computer that can be used to send and receive e-mail

 
Step 1: Open the activation window
1. Open the screen capture app or the video editor.
2. Open the application menu and select Activate Software. The activation window will open:

Step 2: Enter your activation key
1. Enter or paste your activation key into the corresponding field.
2. Select the Activate offline option.
3. Click Activate to proceed to the next step.

Step 3: Send an e-mail with the provided information
The next window contains important activation information that you will need to send us via e-mail in order to activate your
program.
 

http://www.movavi.com/mac-screen-capture/buynow.html?asrc=scsm_help


 

 

1. Click the Copy button to copy the information in the window. If necessary, save or transfer this information to the computer
or device that you will be sending the e-mail from.
 
2. On the computer with an Internet connection, open your mail client and compose a new e-mail. Paste the information
you've copied earlier into the message body and send this e-mail to reg@movavi.com. The activation server will then verify
your activation key and send you an automatic response containing a registration key, which you will need to enter into the
Activation window. You should receive the server's reply within an hour.

Step 4: Enter your registration key
1. When you have received your registration key, save it and go back to the Activation window.
2. Enter the registration key into the corresponding box.
3. Click Activate to submit the information.

mailto:reg@movavi.com


 

 

If everything is correct, you will see a successful activation message. Click Finish to complete the activation and close the
activation wizard.
 
Once activation is complete, you may be asked to restart the application. If you have entered the key correctly, you should
see a message confirming successful activation.  Click OK to complete the activation process and restart the program.
 
If offline activation doesn't work:

• Make sure you have entered the activation key and the registration key correctly and try again
• Check that you are activating the right application.
• Make sure you have administrator rights on your computer

If you have any questions or problems while activating your Movavi software, feel free to contact us and we'll help you out!
Our e-mail: support@movavi.com

mailto:support@movavi.com


 

 

Recording screen activity
Step 1: Open the Capture module
To open the Screen Capture module, launch Movavi Screen Capture Studio and click the Record Screencast button.

Step 2: Choose the capture area
First, you'll need to set which part of the screen you want to record.
Learn more about capture area
 
To record the full screen
Open the list in the left part of the control panel and choose your display under Full Screen.

To record a window
On the capture control panel, click the crosshair button and then click on the window you want to capture. An orange capture
frame will appear around the window.



 

 

To record a custom fragment
On the capture control panel, click the crosshair button. Then, click and drag to draw the capture area on the screen.

Step 3: Choose audio sources
Next, we'll select what sounds you want to be heard in your video.
 
Music or sounds from your computer
To enable recording sounds from your computer (any music, videos, applications, and alerts), click the System Audio
button. Use the slider to the left of the System Audio button to manage the volume of the recording.



 

 

on             off
Microphone or audio device
To record from an external device, click the microphone button and select the device you want to use from the list below it.
Use the slider to the left of the microphone button to manage the device's volume.
Learn more about audio

on             off
Step 4: Extras

If you want to limit the length of the recording or record at a later time, use the Capture time options button: 
Learn more
 

If you want to display your mouse during capture, click the Cursor options button: 
Learn more
 

If you want to show which keys you pressed during recording, click the Record keystrokes button: 
Learn more
 
Step 5: Record the screen
When you're ready, click the REC button to begin recording. The capture control panel will change to show recording
options. Here, you can also keep track of how big the recording is going to be.

To pause the recording, click Pause. When you're ready to continue, click the Resume button.
To finish the recording and proceed to saving, click Stop.
To terminate and delete the recording, click Cancel.
Learn more

Step 6: Save the video
After you end the recording, you can preview the result and choose how you want to save the captured video.
 
Click the 'Save as' box and select the format you want to save the video in.
 
To save as a video format
Click Video and Audio at the top of the list and select the necessary format and resolution.
 
To save for watching on a device
Click Devices at the top of the list. Find your device's manufacturer and click on it, and then select the device's model. This
will save the video in a format that is guaranteed to be supported by the selected device.
 
Finally, click Save to start processing the video.



 

 



 

 

Capturing from iPhone
With Movavi Screen Capture Studio you can record everything that is happening on your iPhone or iPad screen! Create
tutorials, guides, capture videos, live streams and games from you mobile device.
Please note that this feature requires MacOS v.10.10 or higher and iOS 8 or higher. You also need a 'lightning to USB' cable
to connect your mobile device to Mac computer.
 
Step 1: Open the Capture module
To open the Screen Capture module, launch Movavi Screen Capture Studio and click the Record Screencast button.

Step 2: Connect a device
Launch Movavi Screen Capture Studio and connect an iPhone or an iPad to your Mac with a 'lightning to USB' cable. As
soon as a connection is established, you will see a mobile device indicator marked with a green check mark in the main
window.

Step 3: Choose screen orientation
In the Select Capture Area section, open the list of capture area sizes and sources, and find your device in the list.

Next, select the portrait or landscape orientation for your recording



 

 

Portrait orientation      Landscape orientation
 

To avoid black bars around your videos please choose landscape screen orientation.
Although please note that some mobile applications do not support landscape screen
orientation mode, so you might need to choose portrait orientation for such purposes.

Step 4: Start recording
Click the orange REC button to begin recording your device screen.

You will be given a five-second countdown to prepare. If you want, you can disable the countdown window in General
Preferences.
During capture, you can temporarily pause the capturing process by pressing the Pause button or using hot keys.

Step 5: Finish your recording
When all the action on your device screen has be captured, click the Stop button or press ⌥⌥2 to end the recording and
proceed to saving your video.
 
If you want to edit the captured video, click the Edit button in the bottom right corner of the window.
Learn more about editing captured videos.



 

 

Step 6: Choose a format for saving
Now choose a format for your video and and click Save. You video will be ready in just a couple of minutes.
Learn more about saving video



 

 

Capturing YouTube video
This manual describes how to capture videos from YouTube. You can also follow the same steps to capture video from other
video sharing websites, webinars, sports broadcasts and any other online video.
 
Step 1: Open the Capture module
To open the Screen Capture module, launch Movavi Screen Capture Studio and click the Record Screencast button.

Step 2: Choose video quality
Many video streaming websites, including YouTube, allow you to select the quality for playing back the video. To preserve
the best possible quality, we recommend choosing a high resolution in the online video player. The higher the video
resolution you see in the player, the better the quality of your recorded video.
 
Step 3: Define the capture area
In the Capture window open the list of pre-defined capture area sizes and choose one from the YouTube section:
 

640х360 – default YouTube player size

854х480 – extended theatrical mode size. You can toggle sizes by clicking the Theatrical mode  button. 
The capture area frame will be set to the selected size. Then, place the frame over the YouTube player so that the player's

control panel is outside the frame by dragging the frame by the orange position icon .
If you want to capture a fullscreen video, open the list of pre-defined sizes and choose the option under Fullscreen. If you
have more than one monitor, you will be able to choose which one to use for capturing video.



 

 

You can find out more about setting up the capture area here.
 
Step 4: Choose an audio source
On the capture settings panel, click the System Sound button to enable capturing sounds from programs and your system,
including the online video player.
 

off             on
 

Make sure that other sound sources on your computer (for example, videos, streaming mucic, and ads in other browser tabs,
audio players) are muted or disabled to avoid capturing unnecessary sounds. Next, to further reduce noise, we recommend
that you disable capturing audio from external devices.

off               on
 
Step 5: Set up mouse visibility
Click the cursor icon to display the mouse cursor settings panel. To hide the cursor during recording, disable the Show
cursor option.

 
Step 6: Start recording
Make sure that the window with the video player is in the foreground of your desktop. If you've selected the fullscreen
capture mode, don't forget to enable fullscreen playback in the player as well. When you're ready, click the REC button or
use the start capture hotkey to begin recording. The Movavi Screen Capture Studio control panel will switch to recording
mode.
 



 

 

 
During capture, you can temporarily pause the capturing process. If you're capturing in fullscreen mode, the control panel
will be minimized to the system tray. In that case, you can click the buttons in the tray to pause or stop capture, or use the
hot keys.

To finish recording and proceed to saving your video, click the Stop button or use ⌥⌥2 key (the default stop capture shortcut,
your keyboard shortcut settings may be different). The player window will appear.
 

Step 7: Choose format
In the Save as list, choose a format you'd like to save the video in and click Save. Your video will be ready in a few minutes.
Learn more about saving captured videos



 

 

Capturing Skype calls
When you record audio or video calls using Skype or a similar program, it is important that you record both ends of the
conversation. To do that, you will need to record input from your microphone or webcam, as well as the audio from your
speakers. Follow the steps below to record Skype calls with audio.

 
Step 1: Open the Capture module
To open the Screen Capture module, launch Movavi Screen Capture Studio and click the Record Screencast button.

Step 2: Select audio sources
 

• Click the System Sound button to enable capturing the sounds that you hear in your speakers, including your Skype
interlocutor. 

• Click the microphone icon to enable capturing audio from external devices.
• Open the list beneath the microphone icon and select your microphone or another device that will capture your voice.

 

Step 3: Define capture area
Adjust the size of the Capture Area to the call window. To do that, click the crosshair button in the left part of the window, and
then click and drag your mouse from one corner of the Skype call area to another. When you release the mouse button, the
Capture Area will have the same size and position as your Skype window.

Step 4: Capture a call
Now that everything is set it's time to make that call!



 

 

Click the orange REC button to begin recording your call.

You will be given a five-second countdown to prepare. If you want, you can disable the countdown window in General
Preferences.

Step 5: Saving video
When you're done, click Stop in the main Movavi Screen Capture Studio window or press ⌘⌘2 to finish capturing and
proceed to saving the video.
You can change the Stop Capture hotkey in Preferences under Keyboard Shortcuts.
 

 



 

 

Capturing video from players
Step 1: Open the Capture module
To open the Screen Capture module, launch Movavi Screen Capture Studio and click the Record Screencast button.

Step 2: Set up the capture area.
For capturing videos playing in video player applications, it is best if you capture the video as close to its original size as
possible. That is, if the video you want to capture has a resolution of 1280x720 pixels, we recommend that you set the
capture area to the same size. Most video players have a Zoom option, where you can set the zoom level to 100% or 1:1. If
the video is larger than your screen size, you can set the capture area to record the entire screen and then play the video in
full screen mode.
 

• To set a fullscreen capture area:

In the Select Capture Area section, open the list of pre-defined capture area sizes and select the option under Fullscreen.
If you have more than one monitor, you can choose which monitor to use for fullscreen capturing.
 

• To capture a player window:

Click the crosshair button in the Select Capture Area section to enable smart capture area selection. The screen will dim
slightly. Then, draw the capture area inside the player, so that the player's window is completely outside the frame. When
you release the mouse button, this rectangle will be set as your capture area.
Learn more about the capture area

Step 3: Set up the sound
When you want to record audio from applications, you will need to enable the System Sound option. Click the speaker icon
in the Movavi Screen Capture Studio control panel window to enable capturing sound from players and other programs.
As this allows Movavi Screen Capture Studio to record all system sounds, make sure to disable sound alerts in other
applications to avoid unwanted noise in your video.
Learn more about sound recording



 

 

Step 4: Start Recording
To begin recording, click the red REC button or use your Start \ Stop capture shortcut.

If you want to capture a fullscreen video:
1. If you don't remember your start and stop capture hot keys, open the Preferences window, and review them or set
different ones in the Keyboard Shortcuts tab. Don't forget to close the preferences window before starting playback.
2. In your player, switch to fullscreen mode and launch playback
3. To begin recording, press your Start\Stop capture keyboard shortcut. 
 
When you want to end capture, click the Stop button or use the Start\Stop capture shortcut again and proceed to saving
your video.
Learn more about recording videos
 
Step 5: Save the Video
After you've finished capturing the video, you can preview the result in the player and save the video. If you want to edit or
enhance the video, click the Edit button to open the captured video in Movavi Video Editor.
If you want to trim the video, move the triangle markers on the progress bar towards the center.
Open the list under Save as and choose the format you want to save your video in. You can also prepare the video for
viewing on mobile devices or sharing online. When you've selected a format, click Save to begin processing the video.
Learn more about saving captured videos

 



 

 

Making a video tutorial
Step 1: Open the Capture module
To open the Screen Capture module, launch Movavi Screen Capture Studio and click the Record Screencast button.

Step 2: Record your actions on screen
1. In the Movavi Screen Capture Studio window, select the area of the screen that you want to record.
2. Choose which audio that you want to record: system audio to record sound you can hear from your speakers or
microphone to record your voice.
3. Click the mouse cursor icon on the control panel and set up mouse cursor highlighting. This will help you bring attention to
your actions on screen as you record the tutorial.
4. Click REC to start recording. When you're done, click Stop to proceed.

Jump to: Capture Area | Sound | Mouse Cursor

Step 3: Add your video to the Editor
1. After you've captured your screen, click the Edit button to open the captured clip in the Editor. You will be asked to choose
an aspect ratio for your project.
2. In the Editor, click Add Media Files if you want to add more clips to your project.

Jump to: Editing captured files | Setting up a project | Add files to the Editor



 

 

Step 4: Cut the video
To cut the captured video, select the clip on the Timeline, place the position marker where you want to cut the clip, and click
the scissors button on the toolbar. Cutting video

 
Step 5: (Optional) Record and edit audio
To record an audio voice-over:
1. On the Timeline, place the position marker to where you want the audio to start.
2. Click the microphone button on the toolbar to open recording options.
3. Select your microphone under Audio device, set up the volume and click Start Recording. When you're done, click Stop
Recording, and you can find your voice-over as an audio clip on the Timeline.
Learn more about recording
Audio tracks



 

 

To manage the volume for any clip, select it on the Timeline and open the Tools tab. There, set the Volume slider to the
necessary level for this clip.
Learn more about volume levels
 
Step 6: (Optional) Record video from a webcam
Many video tutorials and webinars also have the author's webcam video in the corner. Adding your own webcam video is
easy: first, record the video and then insert it as an overlay.
1. In the Editor, click the Record Video button on the Import tab.
2. The video recording module will open.  There, choose your webcam under Video capture device, choose a microphone
under Audio capture device, and then click Start Capture.
3. When you're done recording, click Stop Capture, and then Back to editing to add the video you've just recorded to the
Timeline.

4. The recording will appear at the end of the video track of the Timeline. To create an overlay, select the webcam clip and
drag it up, towards the top of the Timeline and place it onto the overlay track. The video will now appear in a small part of
the frame over the main video track.
 
5. To change the overlay placement, double-click the overlay clip. Now, you can move and resize the overlay in the player.
Click Apply on the options panel above the player to accept the changes. Now you have both your captured screen and
webcam in the same video.
Learn more about overlays



 

 

Step 7: (Optional) Highlight objects
In addition to highlighting the mouse cursor, you can bring attention to parts of the screen using the zoom and highlight tools.
1. If you have a long recording but you only want to zoom or highlight a part of its length, cut this part into a separate clip and
select it. Cutting clips
2. Open the Tools tab without deselecting the clip. Here, find the Zoom and Highlight and Conceal tools. Tools
3. To zoom in on a clip, select one of the Zoom modes. Then, in the player, select the part of the screen that you want to
enlarge and click Apply in the Tools tab.
4. To highlight a part of the screen, select Highlight inside the Highlight and Conceal tool. Then, use the frame in the player
to select the part of the screen you want to highlight and click Apply in the Tools tab.
 
Step 8: Export the video
Now that you're done with your tutorial it's time to save it in a format that everyone can enjoy.
1. Click the Export button to open the exporting options.
2. In the Export window, select a video format that you want to use and choose a folder to save the video to.
3. Click Start to begin exporting the video. This may take a few minutes.
Learn more about exporting



 

 

Making a movie
Jump to:

Creating project | Adding files | Cutting clips | Editing clips | Filters | Titles | Transitions | Saving the video
Step 1: Open the Capture module
To open the Screen Capture module, launch Movavi Screen Capture Studio and click the Record Screencast button.

 
Step 2: Create a new project
When you open Movavi Video Editor, you will be asked to choose an aspect ratio for your new movie. Choose an aspect
ratio closest to that of the videos and photos you intend on using. You will be able to change this later.
Learn more about projects and aspect ratio

Step 3: Add videos, images and music
On the Import tab of the Video Editor, click Add Media Files to choose the video, audio, and image files you'll be using.
 

Learn more: Adding files | Recording video from cameras  | Recording audio



 

 

When you open the files, they will be placed on the Timeline: the videos and photos on the video track, and the audio clips
on the audio track. To rearrange the clips, simply drag them to the necessary position with the mouse.

Learn more: Using the Timeline | Working with video and images | Working with audio

Step 4: Cut videos
1. Select the clip that you want to split*.
2. Move the position marker onto the moment where you want to cut the clip. You can move the position marker both in the
player or on the Timeline.
3. Click the scissors button on the toolbar to split the video into two parts.

Learn more: Cutting video | Cutting audio
 

* Note that if you select a video clip, its audio track will also be cut, unless you
move it to a separate audio track. Learn how to work with audio on the Timeline



 

 

Step 5: Edit and enhance clips
Select the clip you want to edit, and click the Tools button on the left to see clip editing options. Here, you can edit each
clip's speed and volume, as well as rotate, crop, and adjust the videos.

Rotating clips:
1. Click Rotate and Flip to open the rotation options.

2. Click the arrows to rotate the selected clip 90° clockwise  or counterclockwise .
Learn more about rotating clips



 

 

Enhancing photos and videos:
Auto adjustments can help you enhance your videos and photos in one click, making them more vibrant.
1. On the Tools tab, click Color Adjustments to open the adjustments for the selected clip.
2. Select the auto adjustments that you want to use. Magic Enhance will instantly fix the clip's brightness and contrast.
These enhancements are fully automatic.
Learn more about enhancements

Step 6: Add Filters
Filters can help you change the colors in your photos and videos or add an artistic touch. To apply a filter:
1. Click the Filters button to open the filter library. To preview a filter effect, click on its thumbnail.
2. Drag the filter's thumbnail down onto a clip on the Timeline to apply it. A star icon will appear on the clip.
Learn more about filters



 

 

Step 7: Add text titles
1. Click the Titles button to open the titles collection. To preview a title style, click on its thumbnail.
2. Drag the titles you like onto the top of the Timeline. The title track will appear. Place the titles where you want them to
appear relative to the other clips.
3. To change the text and edit the title style, double-click the titles clip you've just placed. The title properties panel will
appear in the player, where you can edit and move the text.
Learn more about adding titles

Step 8: Add transitions
1. Switch to the Transitions tab, where you can choose animations to smoothly join the clips.
2. Drag-and-drop a transition icon in between two clips on the Timeline.
Learn more about transitions



 

 

 
 
Step 9: Export the finished video
Make sure to save your work once in a while: choose Save from the File menu to save the slideshow project so that you can
access it later.
 
When you're done with the slideshow, click the Export button to open the exporting options. In the Export window, choose
a format you want to save the video in, and name your slideshow. Finally, click Start to begin processing the video. Your
slideshow will be ready in a few minutes.
Learn more about saving your video

Having trouble with something?  E-mail us and we'll help you out! Our e-mail: support@movavi.com
 
 

mailto:support@movavi.com


 

 

Using Screen Capture
Movavi Screen Capture Studio consists of two functional applications: the Video Editor module and Screen Capture module.
With the Screen Capture module you can capture actions on screen for tutorials, record Skype calls, videos from websites or
media players. You can edit them right away in the Editor module. When you launch Movavi Screen Capture Studio, you will
see the Editor window, from where you can switch to Screen Capture module.

Step 1: Open the Capture module
To open the Screen Capture module, launch Movavi Screen Capture Studio and click the Record Screencast button.

 
Step 2: Set up the capture area

Choose a full screen capture mode or click
the crosshairs button to select a window.

Step 3: Set up sound
Choose whether you want to record audio

from your speakers or the microphone.



 

 

Step 4: Extras
Use extra options to enrich your recording.

Schedule events
Highlight cursor

Record keystrokes

Step 5: Record screen
Start the recording by clicking the REC button.

Press ⌥⌥3 to take a snapshot.
Press ⌥⌥2 to start and stop the recording.

Press ⌥⌥1 to pause the recording.
Step 6: Save the result

Learn how to save your recording to a common media format.
Edit captured videos
Reduce output size



 

 

Capture area
The orange frame defines which part of your screen will be visible in your screen recording.
 
Record full screen
To record a full screen video, open the list on the control panel and select your display.
Note: if you have enabled the capture control panel, it will be visible on full-screen recordings. You can disable it in the
Screen Capture Preferences.
Also, the main Movavi Screen Capture window will hide, but you can use keyboard shortcuts or the tray icon to begin
recording.

Record a window
Using the smart selection tool, you can select any window and the frame will be automatically set to its size and position.
1. Click the crosshair button on the Movavi Screen Capture window.
2. The screen will dim slightly. Move your mouse pointer over to the window you want to capture and click on it. An orange
frame should appear around the window.
If you move the window, the capture frame will also follow.

Record a YouTube player
1. Open the list on the Movavi Screen Capture window. There, find the YouTube section and select the size you need. The
smaller size is the regular player size, while the larger size is YouTube's Theatrical Mode.

2. Click and drag the orange square  in the center of the capture frame to move it over the YouTube player.
 



 

 

Learn more about capturing YouTube
 
Record a standard size
You can select from any of the standard or widescreen sizes that match common screen resolutions and windows.
1. On the Movavi Screen Capture window, open the list under 'Select Capture Area'.
2. Select a size that fits your needs.

3. Click and drag the orange square  in the center of the capture frame and move it to the necessary position.
 
Custom frame size
You can set virtually any frame size for your recording using a number of ways:
 

• Draw the capture frame

1. Click the crosshairs button on the Movavi Screen Capture window to enter smart selection mode.
2. The screen will dim slightly. Click and drag diagonally to draw the capture frame rectangle.

• Exact size

If you want to set a specific size, enter the width and height into the boxes on the Movavi Screen Capture window:



 

 

• Drag the edges

Move your mouse pointer over the edge of the capture frame, and click-and-drag at them to change the size of the frame.

Moving the capture frame
To move the capture frame, click and drag at the orange square in the center of the capture frame to move it across the
screen.

 



 

 

Sound
Movavi Screen Capture Studio can capture sound from a variety of sources. 
 
System Audio
To capture audio from applications, music, videos, and other system audio, click the System Audio button to enable
capturing sound from these sources.
 

on          off
 
Recording Devices
If you want to record audio from external devices:
1. Click the microphone button to enable device capturing.
2. Select the necessary device from the list.

on           off
 

If you want to record both system audio and an external device (for example, to capture Skype calls), simply select both
options.

Audio volume
Before you start recording, you can adjust the volume levels both for the system audio and your microphone. To change the
volume, simply drag the sliders up or down.
 
This may be useful for recording tutorials with a voice-over to make sure that the microphone is always louder than the
system audio.

Troubleshooting
If you get an error message when you try to select an audio source or system sound is not recording:
1. Close Movavi Screen Capture Studio.
2. Click the button below to download Movavi Sound Grabber – a free extension that enables your Mac to capture system
sound. Normally, it is installed with Movavi Screen Capture Studio, but it may have been removed from your system or is not
working properly. 

http://www.movavi.com/download-soundgrabber
http://www.movavi.com/download-soundgrabber


 

 

3. When the download finishes, open the .dmg file and install it following the on-screen instructions. For detailed instructions
on the installation process, see the Installing Movavi Sound Grabber section.
4. Restart Movavi Screen Capture Studio. System Audio should now be working properly.
 
 



 

 

Movavi Sound Grabber
Movavi Sound Grabber is a free extension that allows you to capture system sound. It is installed along with Movavi Screen
Capture Studio and acts as a virtual input device, accumulates audio output from various sources, and transfers it to Movavi
Screen Capture Studio.
 
All you have to do is click System Audio button:

off           on
 
You will be able to find the virtual device in Audio MIDI Setup.

 
If you want to remove Movavi Sound Grabber from your system, see the Uninstalling Movavi Sound Grabber section.
If you want to capture system sound but get an error message, see the Installing Movavi Sound Grabber section.



 

 

Installing Movavi Sound Grabber
Movavi Sound Grabber is a free extension that enables you to capture system sounds on your Mac. It acts as a virtual
audio input device and sends the sound from music, videos, and system alerts that you would normally hear through your
speakers to the input channel so that it may be recorded by screen capturing software. By default, Movavi Sound Grabber is
installed with Movavi Screen Capture Studio. However, if you have uninstalled Movavi Sound Grabber or it is missing from
your system, you will need to install it in order to capture system sounds.

1. Click the button above to download the installation package.
 
2. Once the download has finished, open the .dmg package you've downloaded.

  
 

3. Double-click the package icon to launch the install assistant. Then, follow the on-screen instructions to install the software
just like you would install any other program.

4. Restart Movavi Screen Capture Studio if it was running during installation.
 
That's it! You can now easily record system audio using Movavi Screen Capture Studio! To find out how to record system
sound with Movavi Sound Grabber, see the Recording Audio section.
 
 

http://www.movavi.com/download-soundgrabber
http://www.movavi.com/download-soundgrabber


 

 

Uninstalling Movavi Sound Grabber
Since Movavi Sound Grabber is a virtual device and does not show up under Applications in Finder, you need to use an
Uninstall file to remove Sound Grabber from your system.
 
1. Launch Movavi Sound Grabber Uninstaller in your Applications list, or click the link below to download the uninstaller.
 

  Movavi Sound Grabber Uninstaller.zip - 6.5 MB
 

2. Make sure that Movavi Screen Capture Studio is closed and launch the downloaded file. If you see a security warning,
click Open.
 

 
3. You will see the following confirmation dialogue. Click Yes to continue and enter your user password to confirm
uninstallation of Movavi Sound Grabber.
 

Movavi Sound Grabber will then be removed from your system. If you need to re-install Movavi Sound Grabber for capturing
system sounds, please see the Installing Movavi Sound Grabber section.

http://www.movavi.com/download-soundgrabberuninstall
http://www.movavi.com/download-soundgrabberuninstall
http://files.movavi.com/dl/UninstallMovaviSoundGrabber.zip


 

 

Scheduling
Movavi Screen Capture Studio allows you limit capture time for your videos: the program will automatically stop recording
after a specified amount of time has passed.
 
To set a time limit
If you want the recording to end automatically after a certain period of time:
1. Click the clock icon to open the capture time options.

2. Select the 'Stop capture after' option.
3. Enter the time after which the recording should end (hours:minutes:seconds).

To schedule a recording
You can record anything on your screen without even being at your computer, as long as you know when to start and end
the recording.
1. Click the clock icon to open the capture time options.

2. Select the 'Schedule recording' option.
3. Next to 'Start time', enter the date and time when the recording should start.
4. Next to 'Stop capture after', enter the time after which the recording will automatically end (hours:minutes:seconds).



 

 

When the time comes, the recording will begin automatically. Before that, don't forget to set up the capture area and sound.
You do not need to press the 'REC' button for the recording to begin, however, please note that Movavi Screen Capture will
need to be running at the specified time. To ensure that, you can enable autostart in the Preferences.
 

 
Please note that if you haven't yet activated the program, the maximum capture time is two minutes for each video. To learn
more about activating Movavi Screen Capture, see the Activating Software section.
 
If you are starting a lengthy recording, make sure that you have enough free disk space for saving the temporary recording
files.



 

 

Highlighting events
If you're making a video tutorial, it can be very helpful to draw attention to onscreen actions.

 
Highlighting the cursor
To show mouse actions in your video, you can choose to display a standard mouse, highlight the cursor, or use an effect for
mouse clicks.
How to highlight the cursor

Highlighted mouse and left click
Hiding the cursor
Hiding the cursor
If you don't want to see the cursor on your recording, you can hide it so that it won't show up on the finished video even if
you move it over the capture area.
How to hide the cursor
 
Showing the keystrokes
If you're using keyboard shortcuts, you can display every key and key combination that you press on your video. The key
combination will appear at the bottom of your video.
How to show keystrokes
 
 
 



 

 

Mouse cursor effects
Using mouse effects, you can use the mouse as a pointer and show your viewers where to click.
 
Show the mouse cursor

1. Click the mouse icon on the Movavi Screen Capture Studio control panel to open the cursor options: 
2. In the Cursor options box, select the Show cursor option.
The cursor will now appear on your videos.
 
Highlight the mouse

1. Click the mouse icon on the Movavi Screen Capture Studio control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Highlight cursor option.
4. To change the highlight color, click the square next to 'Highlight cursor' to open the palette and select a new
color.
5. To change the diameter of the highlight, use the Size slider.
 
 
Highlight clicks

1. Click the mouse icon on the Movavi Screen Capture Studio control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Highlight clicks option.
4. To the right of the 'Highlight clicks' option, you will see two color squares. Click the left or right square to
change the color for the left or right mouse button respectively.
 
 
Use a click sound

1. Click the mouse icon on the Movavi Screen Capture Studio control panel to open the cursor options:  
2. In the Cursor options box, select the Show cursor option if it is not yet enabled.
3. Select the Mouse click sound option.
4. If you want to use your own sound effect, open the list and choose Add sound. Then, select the sound file that you want
to use.
 
Hide the mouse cursor
If you don't want to see the mouse cursor on your video:

1. Click the mouse icon on the Movavi Screen Capture Studio control panel to open the cursor options:  
2. In the Cursor options box, disable the Show cursor option. The cursor will now be transparent in your videos, even
though you will be able to see it on your screen.



 

 



 

 

Recording keystrokes
It is not uncommon to use keyboard shortcuts for the most frequent actions in some programs. However, if you are making
an educational video, tutorial, or a game recording, it is usually quite hard to show what you are doing if you are using
shortcuts. That is why Movavi Screen Capture Studio includes keystroke recording functionality to help you show essential
shortcuts to your viewers.
 
To enable keystroke recording:

1. On the control panel, click the keyboard icon: . The keyboard options panel will appear.
 
2. In the keystroke recording options panel, select one of the options:

• Keyboard shortcuts only — only key combinations such as ⌘C or ⌘⌘-Esc will be shown on screen. Letters and
keys that do not cause an action will not be displayed.

• All keystrokes — each key you press will appear on screen, including letters and numbers.
 

Once enabled, the keystroke recording icon should turn orange .

To turn off keystroke recording, click the keyboard button once again and disable the options.
 

 
If you see a message when you try to enable keystroke recording, it means that your Mac settings prevent Movavi Screen
Capture Studio from accessing your keyboard. To enable keyboard access, follow the steps below.
 
If you have Mac OS X Mavericks:
 
1. Open System Preferences. You can do this either from the Apple menu, or from the message that appeared when you
tried to enable keystroke recording.
2. Click the Security and Privacy icon.
3. Select the Privacy tab.
4. In the Privacy tab, select Accessibility from the list on the left.
5. You should see a list of apps on the right. Find Movavi Screen Capture Studio and select the checkbox next to it to allow
Movavi Screen Capture Studio to access your keyboard.
 
For more detailed instructions, you can find the relevant Apple help page here.
 
If you have Mac OS X Mountain Lion (10.8) and below:
 
1. Open System Preferences. You can do this either from the Apple menu, or from the message that appeared when you
tried to enable keystroke recording.
2. Click the Accessibility icon.
3. At the bottom of Accessibility settings, select Enable access for assistive devices.

http://support.apple.com/kb/HT6026


 

 

Starting the recording
Begin recording
To begin recording screen activity, do any of the following:

•  Click the REC button on the control panel.
•  Use the start recording keyboard shortcut (⌥⌥2 by default)

 
You will be given a 5-second countdown before recording begins.

Pause recording
To pause recording, do any of the following:

•  Click the Pause button on the control panel.
•  Click the Pause button on the orange panel at the top of the capture frame.
•  Use the pause capture keyboard shortcut (⌥⌥1 by default)

 
When you're ready to resume the recording, the Resume button will be in the same location as the Pause button.
 
To take a screenshot
To save a snapshot of the capture area, do any of the following:

•
 Click the screenshot button on the orange panel at the top of the capture frame: 

•  Press the screenshot keyboard shortcut (⌥⌥3 by default).
 

Screenshots are saved to the folder specified in the preferences. By default, it will be the \Videos\Movavi Screen Capture
Studio\Screenshots folder of your user directory.
 
Stop recording
When you're ready to finish the recording, do any of the following:

•  Click the Stop button on the control panel.
•  Click the Stop button on the orange panel at the top of the capture frame:
•  Use the stop recording keyboard shortcut (⌥⌥2 by default)

 
The recording will end, and you can proceed to saving the output video.
 
If you want to terminate the recording without saving the video and delete the temporary recording file, click Cancel on the
control panel.



 

 

Troubleshooting:

• Capture doesn't start immediately

By default, you will see a five-second countdown after you press the REC button and before the recording begins. You can
use this time to prepare for recording. If you want the recording to start immediately, open the Preferences and disable the
'Show countdown' option.
 

• An orange panel appears on my recording

During recording, you can use the orange panel on top of the capture frame to take screenshots, pause or stop recording,
and keep track of the recording process. If you don't want this panel to appear on your videos, open the Preferences and
disable the 'Show capture control panel during recording' option.
 
 
 



 

 

Saving the captured video
When you end the recording, you will see a player with the captured video which you can preview before saving. If you want
to edit the video first, click the Edit button to open the video in the Video Editor application.
 
How to start editing a video
To edit your video in the Editor, click the Edit button in saving vindow.
 
Step 1: Choose a capture format
 
To save as a video file:
1. Click the 'Save as' box to open the list of output formats.
2. At the top of the list, click Video and audio.
3. Find the necessary format in the list and click on it to see more options.
4. Choose a video codec and resolution that you want to save the video with. To save the video without changing the
resolution, choose the item marked with 'Same as input'.
How to choose a resolution?
 
To save the video for a device:
1. Click the 'Save as' box to open the list of output formats.
2. At the top of the list, click Devices.
3. Find your device's manufacturer in the list and click on it to see more options.
4. Find your device's model and click on it to select it as the output format.
The format, resolution, and other media properties will be selected automatically to ensure compatibility with the selected
device.
 
To save only audio:
1. Click the 'Save as' box to open the list of output formats.
2. At the top of the list, click Video and audio.
3. Scroll down to find audio formats at the bottom of the list.
4. Find the necessary audio format in the list and click on it to see more options.
5. Choose the item with the bitrate that you want. Bitrate affects how much audio quality will be retained after saving. To
save with the original audio quality, choose the item marked with 'Same as input'.



 

 

Advanced settings

If you need to save the video with specific properties, click the cogwheel button  next to the 'Save as' box to manually edit
the media properties for video and audio.
 
Step 2: (Optional) Trim the video
If you have unwanted footage at the beginning or at the end of your video, you can trim it using the triangle markers  on
the player's progress bar. Click a marker and drag it towards the center of the progress bar to trim the video. After this, the
fragments outside the markers will not be saved.

 
Step 3: (Optional) Compress the video
At the bottom of the player window, you can see the estimated size of the output video. If you want to compress the video to
a smaller file size:
1. Click the estimated file size to open compression options.
2. In the file size box, drag the Quality slider left to decrease quality and file size. Keep an eye on the quality in the brackets
to make sure you don't set it too low.
3. Click Apply.

Step 4: (Optional) Export the video



 

 

If you want to add the video to your iTunes library or share it on the web immediately after saving, you can do it using the
export options when saving the video.
 
Add to iTunes – select this option to add the captured video to your iTunes media library.
You will need to have iTunes 6.0 and above installed on your computer to use this feature. You can get the latest version of
iTunes from the official Apple page here.
 
Step 5: Save the video
After you have selected the output format, click Save to start processing the video.

http://www.apple.com/itunes/download/


 

 

Choosing a resolution
How to keep the original resolution
If you open the list of presets under Save as, you will see that some presets are marked with a specific resolution size, such
as 720p or 1080p. While these resolution sizes can help you easily scale your video if you've captured it using one of the
standard sizes, they may not be as effective if you've captured it using a custom capture area size.
 
To save your captured video with the original resolution, you will need to either choose a format from the General Video
group (located under Video and audio formats), or choose a format preset titled 'Same as input'.

 
How to avoid black bars
When you save videos with a different aspect ratio (the ratio of the video's width to its height), the output file may come out
with black bars around it. This happens because a video of one size needs to be fit inside the new frame without deforming
the image itself. Just imaging fitting a rectangle inside a square and vide versa.

To solve this problem, you will need to either save the video without changing the resolution (see above), or change how you
want the video to be placed inside the frame. To do that,
 
1. Choose a resolution size that you want in the preset list. To avoid losing quality, it should closely match the size of the
original video either in width or in height.

2. Click the cogwheel button  next to the Save as list to open settings for the chosen preset.
3. Find the Resize method list and open it. Here, you can choose the way your video will be fit inside the selected frame
size.

Letterbox is the default method that saves videos with the least distortion, but may add black bars in the region
around the video.
Stretch will literally stretch the original video to fill the whole screen, however, this may lead to visual distortions.
Crop will scale the video to fit the entire frame on the short side, cropping anything that does not fit. While some
parts of the video will be cropped, the objects inside the video will maintain their proportions.
Auto uses a combination of both stretch and crop methods.
 

Choose the most appropriate resize method depending on the content of your screencast. You can refer to the image in the
Settings window for a preview. Click OK to accept the changes and close the window.



 

 

Small resolution videos
For best results, choose a resolution size less than or equal to that of the capture area you used. Due to video compression
restrictions, If you save your video to a larger resolution, you will not get better quality, but the file size will be considerably
larger.
 
Setting a custom resolution
To set a resolution that is not included in the list of presets:
1. Choose a preset with the necessary format. You can choose any resolution at this point.

2. Next to the Save as list, click the cogwheel button  to open the settings for the chosen preset.

3. Enter the necessary frame size in the Width and Height boxes. Note the link button to the right of the Height box: .
By default, the width and height you enter will be adjusted to fit the selected proportions. Click the link button to disable
proportion constraining.

 - maintain proportions

 - custom proportions

Please note that if you want to save videos for a mobile device, some devices may not support the new custom resolution.
For best compatibility, please a preset for your device in Devices section.



 

 

Reducing output size
Long recordings with a large capture area size may take up a lot of disk space. When saving the video, you can see the
estimated file size at the bottom of the player window. This shows approximately how large the ouput video will be after
saving with the currently selected format. 

Here are some things you can do to reduce the file size:
 
Use a smaller resolution
When you select an output format, choose a resolution that's slightly lower than the original video size. The resolution is
listed next to each output preset:

For example, changing the resolution from 1080p to 720p can reduce the video up to half the size. However, note that
resolution affects video quality, so setting a resolution too low can reduce its quality.

 
Compress the video
When saving the video, you can reduce the quality in order to achieve a smaller file size.
 
1. Click on the estimated file size at the bottom of the player window to open compression options.
 
2. Drag the Quality slider to the left to reduce the video's bitrate. Bitrate is the amount of data in each second of the video.
A slightly lower bitrate may not even be visible to the eye, but it can significantly reduce the file size. The text in brackets will
tell you if you've set the quality too low.
 
3. Click Apply to accept the changes.



 

 



 

 

Uploading videos to iTunes
You can upload the finished videos straight to iTunes. Follow the steps below if you want to learn to upload your captured
videos to iTunes.
 
Step 1: Choose the option
Before you save a video, click the 'Add to iTunes' option at the bottom of the player window.

Step 2: Save the video
Click the Save button to begin video processing. When it will be done, you will see iTunes page with your file listed for
upload.

 



 

 

Editing captured video
After you click the Stop button, a saving window will open. If you want to edit captured video in the Editor, click Edit in
bottom right corner of the window.

The Editor will open with captured video already being added to the Timeline.

See also:
Split video
Editing tools
Saving videos in the Editor



 

 

Recording and saving audio

Movavi Screen Capture Studio can help you not only record any screen activity, but it can also function as a sound recorder
to record online music, radio broadcasts, and voice input.
 
Step 1: Set up Audio
Naturally, if you want to record an audio file, you'll need to enable audio recording.

• To capture audio from your computer, make sure that the System Audio option is enabled.
• To capture audio from a microphone or an external device, click the microphone icon and choose the device you

will be using for recording.
• To capture Skype audio, you'll need both options enabled in order to capture the audio from the other end of the

call as well your own microphone input.

Learn more about recording audio

Both System Audio and device recording are enabled.
 
Troubleshooting
If you get an error message when you try to select an audio source or system sound is not recording:
1. Close Movavi Screen Capture Studio.
2. Click the button below to download Movavi Sound Grabber – a free extension that enables your Mac to capture system
sound. Normally, it is installed with Movavi Screen Capture Studio, but it may have been removed from your system or is not
working properly. 

3. When the download finishes, open the .dmg file and install it following the on-screen instructions. For detailed instructions
on the installation process, see the Installing Movavi Sound Grabber section.
4. Restart Movavi Screen Capture Studio. System Audio should now be working properly.
 
 
Step 2: Set up Video
No video:
If you'll only be recording the audio, or if there's no video at all, we recommend that you make the capture area smaller, so
that video recording does not unnecessarily take up your disk space. To do that, you can resize the capture area with your
mouse, or enter smaller dimensions in the Movavi Screen Capture Studio window. You can set the capture area to as small
as 16x16 pixels.
 
With video:
If you'll also be recording video, move the capture area over the video:

• Drag at the orange square in the center of the capture area to move the frame
• Drag at the corners of the frame to resize the capture area.

More on setting up the capture area

http://www.movavi.com/download-soundgrabber
http://www.movavi.com/download-soundgrabber


 

 

 
 
 
Step 2: Record
Click the REC button to begin recording. You will be given a 5-second countdown to start the audio playback (don't worry
you will be able to trim the file later if you accidentally record some silence). When you're done recording, click the Stop
button.

Step 4: Save Audio
When the recording is finished, you will see a player window, where you can preview and save the recording as an audio file.
 
Trim the file:
If you've accidentally recorded some unwanted parts, like silence at the beginning or at the end of the file, you can easily
trim them before saving the file. At both ends of the progress bar, you will find a pair of triangular trimming markers. These
markers control which part of the recording is saved in the output file. Move the triangle markers so that the unwanted parts
are outside of them.

Trimming markers
Save the file:
1. If you're ready to save the audio file, open the Save as list and click the Video and audio tab at the top of the list.
2. Scroll to the very bottom of the list to find audio formats and choose the format you like. If you're unsure, you can use
*.mp3, as it is the most widely supported format.
3. Click the Save button to start saving the video.

 



 

 



 

 

Saving previously captured files
When you record videos using Movavi Screen Capture Studio, they are first stored as files with the *.mscproj extension.
These files are located in the directory you've specified in File Preferences, or in the default /Movies/Movavi Screen Capture
Studio/Projects folder. You can later open these captured files in Movavi Screen Capture Studio and save them in the format
of your choice.
 
To open the temporary files:
1. In the menu bar, open the File menu and select Open Captured File ( O)
2. Select the *.mscproj file you want and click Open. You can now save the video just like after any other capture.



 

 

Saving screenshots
You can save snapshots of any area of your screen, including videos playing in various media players.
 
Taking screenshots before capture:
1. Open Movavi Screen Capture Studio and click Capture Screen to launch the screen capture module.
2. Set up the capture area to include the part of your screen you want to take a snapshot of, or click the list of standard
resolutions and choose a variant youu need. For more information, please see the Capture Area section.

3. Take a screenshot:

•  Select Take a Screenshot in the Capture menu
•  Or use screenshot shortcut key (⌥⌥3 by default). You can change it to a custom key or key combination in

preferences.

4. In screenshot saving window choose a destination folder for screenshots, choose suitable file type from Files of type list
and finally click Save.
 
Taking screenshots during capture:

•  Select Take a Screenshot in the Capture menu,
• Or use screenshot shortcut (⌥⌥3 by default). You can change it to a custom key or key combination in

preferences.

 
After capturing video you will see a number of screenshots taken during capturing at the bottom of the saving window. You
can also click on the number to open screenshots folder. The screenshot destination folder can be changed in preferences.

Tip: if the main window is visible inside the orange capture area during capture (for instance, when
you capture fullscreen on a one-monitor personal computer), it will be visible on screenshots as well.

We advice you to minimize the main window during capture and use shortcut keys for taking screenshots..



 

 

Screen Capture preferences
 
To open the program settings for Movavi Screen Capture Studio for Mac, open the Movavi Screen Capture Studio
application menu in the menu bar and select Preferences.
 

The preferences are organized into four categories: General, Files, Keyboard Shortcuts, Video, and Audio.
 



 

 

General preferences
The General tab allows you to change the interface language and set the folder where you want the captured files to be
stored by default.
 

 Select the Automatically check for updates option to make sure your Video Converter is always up-to-date. Minor
updates are absolutely free (for example, from v.1.3 to v.1.4). For major updates users with purchased Movavi Screen
Capture Studio license will get a considerable discount.
 

 Send anonymous usage stats to Movavi – checking this box will allow Movavi Screen Capture Studio to send usage
statistics to our development team, enabling us to fix any bugs you may encounter much faster, as well as add new features
that you might be missing. The data sent by Movavi Screen Capture Studio contains no personal information, will not be
disclosed to third parties and will be used for software improvement purposes only. You can find more information about
usage statistics on our Movavi Improvement Program page.
 

 Show countdown – with this option selected, whenever you start capture, recording will not begin right away, rather, you
will be shown a 5-second countdown to give you time to prepare.
 

http://www.movavi.com/mip.html


 

 

File preferences
The Files tab of Movavi Screen Capture Studio preferences allows you to manage the folders where you want Movavi
Screen Capture Studio to store its files. Click the arrow button next to a folder to set a different location.
 
Directory for captured files: where your output videos will be saved. After you save a video, this folder will open
automatically.
 
Directory for screenshots: if you take screenshots during capture, they will be saved to this folder.
 
Directory for temporary files:
When you record screen activity, Movavi Screen Capture Studio first writes your video as a temporary project file with
the *.mscproj extension. This file is stored in your Directory for temporary files until you save it as a video or audio file.
Besides, you can always open a project file and resave it in a different format.
 
By default, the files are stored even after you save the video, in case you want to reuse the temporary file and save it
to a different format, however you can delete all temporary files by clicking the trash can icon next to the Directory for

temporary files .
 

 Delete temporary video files after conversion – with this option selected, the temporary files will be deleted
immediately after you save the videos. This will help you save disc space, however you will not be able to save the recording
in a different format afterwards.
 

 



 

 

Keyboard shortcuts
The Keyboard Shortcuts tab allows you to set your own custom shortcuts for such actions as starting or pausing the
capturing process. On the left you can see keyboard shortcuts for every action.
 

To change one of the shortcuts:
 
1. Click inside the box with the shortcut you want to change. The box will become blank.
2. Simultaneously press the keys you want to use as a shortcut to the selected action. The box will now display your custom
shortcut.
Please note that you will not be able to use certain key combinations that are already reserved by your Mac OS, as your
system shortcuts will have precedence over individual application shortcuts. You can find the full list of reserved system
shortcuts on the official Apple support page.
3. Click OK to apply the changes.
 
In case you forget a shortcut, you can always look it up here in the keyboard shortcut settings.

http://support.apple.com/kb/ht1343


 

 

Video preferences
The Video tab contains advanced video settings. If you need your videos in another format, we recommend that you save
them in the necessary format after capturing. Please see the Saving video section for more details.

Codec: the codec which will be used for capturing videos. The H.264 codec is suitable for most video capturing scenarios.
 
Maximum capture frame rate: like in regular video, the frame rate will define how many frames will be captured
each second. A lower frame rate will result in smaller output size, however, the video may not turn out as smooth. The
recommended frame rate is 20-30 frames per second.
 
Output frame size: defines the dimensions of the captured video. Full size means that it will be captured "as-is", while other
frame sizes will result in some scaling to fit the captured area into the specified frame.

 
For example, if you are capturing a 1280x720 screen with a frame size of 480x320, the captured image will need to be
scaled down. Likewise, if the area you are capturing is smaller than the output frame size, the video will need to be scaled
up, which results in larger file size with no gain in quality.
 

 Enable SuperSpeed conversion – the SuperSpeed conversion method allows Movavi Screen Capture Studio to save

your recordings much faster if you select presets marked with the green SuperSpeed icon .
 
Setting custom video preferences allows you to save time if you intend to always capture videos in one format, but some
options like a higher frame rate and larger frame size will require more resources. We recommend that you keep the default
settings and convert your videos to the necessary format and frame size when saving.
 



 

 

Audio preferences
The Audio tab allows you to change the preferred audio quality, including the sample rate, number of channels, and bits per
second.
 

 



 

 

Using Video Editor
Movavi Screen Capture Studio consists of two functional applications: the Screen Capture module and the Video Editor
module. Using the Video Editor, you can edit the captured videos, join them with additional material, add a soundtrack, and
even create new movies from scratch.

Step 1: Capture video
Capture screen
Capture YouTube videos
Capture Skype calls
Capture from players
Import video from a camera
 

Step 2: Add media
Add videos, photos, and music to your video project.

Open captured videos in the Editor
Record video from cameras

Record audio
Arrange files in a project

 

Step 3: Edit video
Edit and enhance the video clips to

make your video just the way you like it.
Cut and split video

Rotate clips
Crop the frame

Apply cool filters
Step 4: Join clips with transitions

Drag-and-drop transitions from the Video Editor's
extensive collection to join clips with fun animations.

Step 5: Annotate your video
Get your thoughts across with sound and text.

Record a voice-over
Add text titles

Step 6: Save your video
Export your project to a common video format.

Save for devices
Save for uploading online



 

 

Creating a new project
First of all, you will need to create a new project and select some of its parameters.
 
Creating a new project
1. Open the File menu and choose New Project.
2. A dialog box will appear. Here, you can select the parameters of your movie.
3. Choose an aspect ratio for your project by clicking the 16:9 or 4:3 button.
4. Click OK to continue with your project.

What is a project?
A project is a file with the *.mep2 extension that stores all your work on the movie, including the order of videos on the
storyboard, and any other changes you have made while editing the video. Project files can only be opened with Movavi
Video Editor.
 
What is aspect ratio?
Aspect ratio describes the proportions of the video frame, and is basically the ratio of the video's width to its height. When
choosing a project, you can choose between two most common aspect ratios: 16:9 and 4:3. 16:9 is the most common
aspect ratio used for digital videos, especially widescreen movies, while 4:3 is closer to a square, and was used for analog
television. 

A visual comparison of the two common aspect ratios
 

Ideally, the project's aspect ratio should match that of the photos and videos you plan to use in your movie. This way, all of
the photos will fit inside the frame nicely. If you add files with a different aspect ratio, they may appear to have black bars
around them, like so:

 
Adding 4:3 photos to a 16:9 project and vice versa

 

http://www.movavi.com/mac-video-editor/
http://www.movavi.com/mac-video-editor/


 

 

You don't have to choose the perfect aspect ratio right away, if you're unsure, you can always change this later in project
settings, or fit the images into the selected frame. 
Learn more about project settings
Learn how to get rid of black bars
 
Advanced settings
If you need to set other parameters, click the Advanced settings button in the project window. You will be able to choose
the following:
 
Frame size:
You can use this to choose a set frame size (width and height) of the project. If your photos have a different aspect ratio, you
can select Custom and enter the photos' width and height into the boxes below to set their proportions for the whole project.
 
Resize method:
This affects the way photos and videos are resized to fit the project's frame size. Photos with the same aspect ratio as that of
the project will fit in nicely, while others will need to be somehow adjusted in order to avoid black bars on the sides. You can
choose one of the following options:

• Letterbox - the photos and videos will retain their original proportions, and will be resized to fit inside the frame.
• Stretch - the photos and videos will be resized to fit inside the frame as best as possible, and then stretched to

fill the remaining space. This allows to fill the entire screen without black bars, but it may distort objects in the
photos.

• Crop - the photos and videos will be resized in such a way as to fill the entire frame without changing their
proportions at the expense of cropping away the edges. This allows to fill the entire screen nicely, but some parts
around the edges will not be visible.

 
Sample rate:
This affects audio quality. The default option, 44100 Hz, is suitable for most projects.
 
Channels:
This affects the number of channels in the project's audio. You can choose between mono (one channel) and stereo (two
channel) sound, but stereo is usually best for most projects.
 
If you want to change these later, open the project settings.
 
See also:
Saving your work
Project settings
Exporting your movie



 

 

Add media files
To begin working on your video project, you will first need to add some media files to the Editor.
 
Open the Import tab
The Import tab contains options for opening and creating media. To open it, click the Import button in the upper left-hand
corner of the Video Editor window.

The Import tab is the first one you see when you open Movavi Video Editor.
Adding video, photo, and audio files
If the media you want to use is stored in a file, use the buttons on the Import tab or drag-and-drop media files straight from
Finder window onto the Timeline to add them to the project.

• To add one or several files from a single folder, click Add Media Files and choose the files you want to use.
• To add the contents of an entire folder, click Add Folder and select the folders you want to import.

Recording video
You can also record video from your webcam, record clips from a TV tuner or import files from a digital camera.
1. Click the Record Video button. The Video Capture module will open.
2. In the Video Capture window, set up your video and audio capture devices.
3. Click Start Capture to record the video.
When you're done, click Back to editing to import the recordings into the project.
Learn more about recording video



 

 

Using stock audio
If your project is missing cool footage, music, or backgrounds, use the free stock clips included with the Video Editor.
 
Sample audio
1. On the Import tab, click the Sample audio section to open the free stock audio collection.
2. Click on an audio clip to preview it.
3. Once you've picked a clip you like, drag it onto the audio track of the Timeline.
To find more songs for your project, click Download more and subscribe to AudioBlocks.com — a stock audio bank where
you can find thousands of songs, themes and audio samples.
 
Stock video
1. On the Import tab, go to the Sample video section to open the free video collection.
2. Click on a clip to preview it.
3. Once you've picked a clip you like, drag it onto the video track of the Timeline.
If you can't find the right clip, click Download more and subscribe to VideoBlocks.com — a stock video collection with
thousands of royalty-free videos, footage clips and animations.
 
Backgrounds
1. On the Import tab, go to the Backgrounds section to open the free stock background collection.
2. Pick a background you like and drag it onto the video track of the Timeline.
For more backgrounds, click Download more and subscribe to GraphicStock.com. Here you can find backgrounds,
illustrations, vector graphics and design elements for every project.
 
Capturing screen activity
Click the Record Screencast button to open Movavi Screen Capture and record a new video.
Recording screen activity
 
Arranging files on the Timeline
Once you've added the files, they will appear on the Timeline at the bottom of the Movavi Video Editor window. The Timeline
allows you to arrange the clips in the order you want. The clips' position relative to the time markers at the top of the Timeline
determines when it will appear in the finished video. To reorder the clips, select the clips you want to move and then click
and drag them to the new position on the Timeline.
Learn about using the Timeline

http://www.movavi.com/stock-video-footage/?asrc=scs_help


 

 

Moving a clip on the Timeline

See also:
Working with video
Working with audio



 

 

Recoding video

Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device
and that it is working correctly.
 
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and
frame rate. A larger resolution will be able to retain better quality, however, the video file size will be larger. A higher frame
rate is necessary for recording motion, while static scenes can be captured with a lower frame rate.
 
Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.



 

 

Step 5: (Optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them
somewhere else, click the folder button under 'Save files to' and choose a different location.

Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up
the new file name template. 

Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button

 on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.
 
Step 9: When you're done, click Back to editing at the bottom of the window. The captured files will be added to your
project's Timeline. Also, they are saved to disk in case you want to use them later.



 

 



 

 

Recording audio
After you've added some videos and photos to the Timeline, you can record audio from a microphone or any other recording
device.
 
Step 1: Set up recording
1. Click the Record Audio button on the toolbar to open audio recording options.

2. In the Input source box, choose the device you want to use.
 
To record from a microphone: choose your preferred microphone or webcam microphone. If you don't see the device in
the list, try reconnecting it to your computer.
To record audio from the computer: select Stereo Mix from the list. This will allow you to record any music, alerts, or other
sounds playing on your computer.
 
3. Set the volume level you want to use in your project.
4. On the Timeline, place the progress marker to where you want the recording to begin.

Step 2: Record sound
1. When you're ready, click Start Recording. You will be given a 5-second countdown.
2. The video will start playing simultaneously with the recording. This way, if you're recording a voice-over, you will be able to
use the video as a visual aid as you speak.
3. When you're done, click Stop Recording. The recorded audio clip will already be on the Timeline, as a linked audio clip.

audio_tracks.htm#linked_audio


 

 

Importing AVCHD video

Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera.
Make sure that the system recognizes the device and that it is working correctly.
 
Step 2: On the Import tab of the Video Editor, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, select your AVCHD camera.
 
Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't
need.
 
Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere
else, click the folder button under 'Save files to' and choose a different location. 

 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up
the new file name template. 



 

 

 
Step 7: Click Add files to the Editor to start copying the files. This may take a while depending on the size of the videos.

 
 



 

 

Using the Timeline
Jump to: Timeline tracks | Zooming the Timeline | Previewing clips | Arranging clips | Position marker

 
The Timeline, located in the bottom part of the window, is the working area that allows you to organize and edit the clips. The
Timeline consists of several tracks, which are all synchronized to a single time scale at the top, which indicates the time of
the project.
 
Timeline tracks
The Timeline is made up of several tracks, one for each media type, that allow you to arrange the clips in chronological
order; mixing and joining the clips together to create your unique video.
 
Video track
The video track contains video clips and their attached audio, images, and transitions between clips.

• You can link audio and titles to video and image clips so that they will stay in sync as you edit the project.
• You can rotate, adjust, and use other tools on video and image clips on this track.
• You can apply filters to video and image clips on this track.

 
Linked audio track
The linked audio track contains audio clips that are linked to video clips. At the beginning of each linked clip, you can see a
blue line that connects it to the video or image clip it is linked to. When you move, split, or delete the clip on the video track,
the linked audio clip will also be edited with it. This is useful if you've synchronized the clip's audio to the video track and
don't want it to change as you edit your project.

• The linked audio track is hidden at first, until you drag an audio clip between the independent audio track and the video
track.

• You can edit the audio clips' volume and speed in the Tools tab.
• You can have several audio clips playing simultaneously. To do that, simply place them one under the other.

 

Independent audio track
The separate audio track contains audio clips that are not dependent on clips on the video track. This track is good for
background music.

• You can edit the audio clips' volume and speed in the Tools tab.
• You can have several audio clips playing simultaneously. To do that, simply place them one under the other. 

Learn more about audio tracks

Titles track
The titles track contains text clips that will appear on top of all other clips.
You can change the titles' duration on the Tools tab, or by dragging the edge of the title's clip on the Timeline.
Learn how to place titles
 
Overlay track
The overlay track contains additional video and image clips to create special effects like Picture in Picture or Chroma Key.

• Clips on the overlay track are linked to clips on the video track and will stay in sync as you edit the clips.
• You can apply filters and use all of the Tools to edit the clips on this track, just like any other video or photo.
• You cannot join clips on the overlay track with transitions.

Learn about using overlays
 
To select all clips on a single track, click the area with the track's icon to the very left of all clips.

using_the_timeline.htm#timeline_tracks
using_the_timeline.htm#zoom_timeline
using_the_timeline.htm#previewing_clips
using_the_timeline.htm#arrange_clips
using_the_timeline.htm#position_marker


 

 

 
Zooming the Timeline
To change the zoom level of the Timeline, drag the Scale slider at the bottom of the window. Move the slider left to zoom out,
and move the slider right to zoom in on the Timeline.

Previewing clips
To preview a clip, click on it on the Timeline. The position marker will move to where you've just clicked, and the current part
of the clip will be shown in the player. Click Play in the player to watch the video.
 
Rearranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips,
drag them with your mouse and drop them onto the desired position. To select multiple clips use ⌥+click.

Moving the position marker
The position marker defines the currently selected point on the Timeline. There are two position markers: the orange line
on the Timeline, stretching down from the time scale all the way through all of the tracks, and the position marker on the
progress bar of the player. Both denote the current position relative to the whole project and show identical time.
 
The timestamp in the player displays the currently selected time from the beginning of the project.



 

 

 
There are several ways to move the position marker:
 

• Click anywhere on the Timeline to move the position marker to that position.
• Drag the position marker (either on the Timeline, or in the player). For higher precision, try zooming in on the Timeline.
• Press the left or right arrow key to move to the beginning of the previous and next clip, respectively.
• To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds or Skip

Backward by 0.5 Seconds.
• To move precisely from frame to frame, use the 'Back' and 'Forward' buttons in the player. This will move the position

marker exactly one frame backward or forward.

See also:
Editing tools
Audio tracks
Extracting audio from video



 

 

Editing video and photo
After you've added some files to the project, it's time to edit them and create a beautiful video.
Learn how to add media files
 
Using the Timeline
When you add files to your project, they appear on the Timeline in the bottom part of the window. The Timeline allows you to
view the relative length of each clip along a time scale, and make several clips play simultaneously. All videos, pictures and
the transitions between them are located on the video track of the Timeline. To change the order in which they are played,
simply drag-and-drop the clips to the necessary position.
Learn more about the Timeline

Cut and split video
On the Timeline, select the clip that you want to cut and move the position marker onto the moment where you want to split
the clip. Then, click the scissors button on the toolbar to split the clip into two parts.

If you want to cut out a part of the video, repeat the steps to cut the unwanted fragment at the beginning and at the end,
turning it into a separate clip on the Timeline. Then, select this fragment and press the Delete key on your keyboard. The
unwanted fragment will disappear, and the remaining clips will move up the Timeline to fill in the blank space.
Learn more about cutting videos
 
Add filters
To apply an artistic filter to your clip, simply open the Filters tab and drag a filter you like onto a clip.
Learn more about filters



 

 

 
Picture in picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of
the Timeline to create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on
the video.
Learn more about overlays
Learn more about Chroma key

Picture and picture, side by side overlay modes, Chroma key.
 
Using the editing Tools
The Tools tab also has other tools and special effects that you can use on your videos and images. To use the tools, select a
clip on the Timeline and open the Tools tab. There, click on the tool you need and select the necessary options.
Learn more about Tools



 

 

Change image duration
1. Select the images you want to edit.
2. Click the cogwheel button on the toolbar. The Tools tab will open.
3. In the the Tools tab, enter the length you want into the Duration field. The format is hours:minutes:seconds:milliseconds.
The changes will apply immediately.

Manage video volume
1. Select the images you want to edit.
2. Click the cogwheel button on the toolbar. The Tools tab will open.
3. In the the Tools tab, set the Volume slider to the necessary volume. The changes will apply immediately.



 

 



 

 

Cutting video
Using Movavi Video Editor, you can easily split videos into parts and cut out fragments with the Split tool. You can find it on
the toolbar of the main window, marked with scissors icon: 

Splitting video into parts
1. Select the clip you want to split on the Storyboard.
2. Place the position marker at the point where you want to divide the clips.
3. Click the Split button to divide the selected clip into two clips at the specified time.
Note that if the clip has linked audio, the audio clip will also be split.

Cutting out fragments
1. Place the position marker onto the beginning of the fragment that you want to cut out.
2. Click the Split button  to divide the clips at the specified time.
3. Place the position marker onto the end of the fragment you wish to remove. If the fragment is located at the very end of a
clip, skip to step 5.
4. Click the Split button  again to divide the clips. Now, the fragment is located in a separate clip.
5. Select the clip with the fragment and press the Delete key, or the Delete button on the Toolbar. The fragment will be
removed from your project.

For more precise navigation:

• To jump to the beginning of a specific clip, click its thumbnail on the Storyboard.
• Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to

jump half a second forward or back.
• Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: ⌥⌥←

and ⌥⌥→.
• Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the ⌥← and ⌥→

keyboard shortcuts.

audio_tracks.htm#linked_audio


 

 

 



 

 

Applying filters
Using filters you can alter the mood of the video, make an old movie, overlay cool flying objects, and more.
 
Step 1: Open the Filters tab
Click the Filters button to open the filters collection. Click on a filter's thumbnail to see its preview in the player. If you're
looking for a specific filter, you can enter its name into the search box.

Step 2: Apply the filter
When you've found a filter you like, drag its thumbnail onto the clip you want to apply the filter to.

Once you've applied a filter, a star icon will appear on the clip, denoting applied filters and tools.

Clip with an applied filter
Removing filters

To remove a filter, click on the star  icon on the clip to see the list of applied filters and tools. In the list, select the filter that
you don't want and click Remove.



 

 



 

 

Adding overlays
Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture
in picture effect, add a logo or watermark, or insert a short clip without cutting the main video. Also, you can use overlays
with the Choma key tool.
 
Before you start:
You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your
project. You can use images in PNG format to add transparent logos.
 
Step 1: Place the overlay clip
1. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.
2. Drop the clip onto the overlay track, where you want it to be shown relative to the main video track.
Note that a blue line now connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip:
if you move, cut, or delete the main clip, the overlay clip will also be edited.

Step 2: Edit the overlay
1. Double-click the overlay clip to set it up. An options panel will appear in the player.
2. Open the drop-down box on the overlay panel and choose how you want it to appear on the video: Picture in picture,
Side by side, or Cover.

Picture in picture
This is the default overlay mode. Using picture in picture mode, you can show the overlay video over any part of the screen.
1. Choose Picture in picture mode from the drop-down box.
2. In the player, move the overlay to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners.
4. Deselecting the Constrain proportions option will allow you to resize the overlay to any proportions, but a drastic change
in proportions may make the overlay look distorted.



 

 

Picture in picture overlay
 
Side by side
1. Choose Side by side mode from the drop-down box.

2. Use the buttons on the panel to choose how you want to align the two videos: 

Side by side overlay
Cover
Cover mode can be used for a short insert into the main video without having to cut it. While the main video (and audio!) is
playing, the overlay clip will appear on screen for the duration of the overlay clip.

Cover overlay (the main clip is hidden)
Chroma key
The chroma key effect can be used to remove any solid color and create transparency. This effect is commonly used in
movie production, when the actors are filmed in front of a green or blue screen, and then, during production, the color in
replaced with an interesting background.
1. Choose Chroma key mode from the drop-down box.
2. On the video, click on the color that you'd like to remove. The more uniform the background is, the better it will be
removed.
Hint: if nothing happens, click on the square next to the mode selection box. When you're in color selection mode, the video
is surrounded by a yellow frame.
3. Use the Tolerance slider to set how much deviation from the selected color is allowed. Higher values will remove similar
colors to the one you've selected.
4. Use the Border sharpness slider to set how much edges around the remaining parts should be smoothened out.



 

 

Chroma key overlay
 
Step 3: Apply the changes
After you've set up the overlay, click the Apply button on the overlay options panel.
 
Step 4: Overlay clip tools
You can also edit each overlay clip's speed and opacity. To do that, use the Volume, Speed, and Opacity sliders in the
General section of the Tools tab. Keep in mind that you can also use other clip editing tools on overlay photos and videos!
Learn more about tools
 
 



 

 

Editing tools
The Tools tab allows you to edit the selected clip and add special effects. To use the tools:
 
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an image clip on any track. Also, you
can edit the volume for audio clips.
 
Step 2: Click the Tools button on the left side of the window to open the Tools tab. Here, you will find the selected clip's
basic properties, such as volume and speed.

Step 3: Choose the tool that you want to use and click on it to see more options.
 
Step 4: Set up the tool however you want to use it. Don't forget to click Apply to keep the changes!
 
After you've used a tool on the clip, it will be marked with a star icon, denoting applied tools or filters.

Removing the changes
On the clip, click the star icon to show the list of applied tools. Then, select the tool you want to discard and click Remove.
Also, you can deselect the tool on the Tools tab.



 

 

General clip properties
At the top of the Tools tab, you can edit the basic clip properties including volume, speed, opacity and duration.

Volume – can be used to adjust the loudness of video and audio clips. 100% is the original clip's volume. Learn
more
Speed – can be used to speed up or slow down video and audio clips. Learn more
Opacity – can be used to make overlays transparent. Learn more
Duration – can be used to set how long the selected image or titles clip will appear on screen. Learn more
Fade in, Fade out – can be used to smoothly fade a video or sound. Learn more

 
Color adjustments
Movavi Video Editor can automatically enhance your videos and photos, improving contrast, saturation, and white balance.
Select a clip and click the Color Adjustments button on the toolbar to open the enhancement options.
Learn more about enhancements

 
Crop video
When you open the Crop tool or click the Crop button on the toolbar, a frame will appear inside the player. Use this frame to
crop the video and click Apply to accept the changes.
Learn more

Rotate video and images
Using the Rotate and Flip tool, you can rotate videos by 90°, flip them vertically or horizontally, or apply a cool mirror effect.
Learn more



 

 

Zoom
With the Zoom tool, you can create a panning or zooming effect. Choose a zooming mode and then set the zoom target
using the frame in the player and click Apply.
Learn more

Zooming and panning
Chroma key
Using the Chroma key tool, you can remove a color from an entire video and replace the background with any other video
or photo.
Learn more

Replacing a green background with the Chroma Key effect.
 
Highlight and conceal
Use this tool to blur or darken a part of the video. This way you can hide certain objects, like license plates or other private
information, or highlight things you want to show!
Learn more



 

 

Left to right: no effect, soft focus, conceal.
Stabilizing videos
Use the stabilization tool to remove camera shake from your footage.
Learn more

Before and after stabilization
 



 

 

Volume level
This section explains how to manage the volume of video clips.
 
Step 1: On the Timeline, select the video that you want to edit.
 
Step 2: Click the Tools button to open the tools for the selected clip.
 

Step 3: Drag the Volume slider to set the volume for the selected clips. 100% is the original volume. To mute the clip, drag
the slider down to 0%.
 

 
 



 

 

Speed
With the Speed tool, you can speed up or slow down a video or audio clip. This can be useful if you're working on a music
video and you want the video to match the tempo of the music.
 
Step 1: On the Timeline, select the clip you want to edit.

• Note that slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above.
• You can also change the speed of any audio clip.
• If you modify the speed of a video with built-in audio, the audio speed will also be changed.

 
Step 2: Click the Tools button to open the editing tools for the selected clip.

Step 3: Drag the Speed slider to set the necessary video speed, where 100% is the video's original speed.

You can see the current length of each slide right under its preview on the storyboard. If you've changed video speed, the
video clips will be marked with a speed icon:



 

 

Changing image duration
By default, all images will be shown for 4 seconds each. To change the duration:

 
Step 1: On the Timeline, select the image clip that you want to edit.
 
Step 2: Click the Tools button to open the tools for the selected clip.

Step 3: In the Duration box, enter the new length of the image. Use the following format: hours:
minutes:seconds.milliseconds. Changes will be applied instantly.

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The
longer the clip appears on the Timeline, the longer it will play in your movie or slideshow.

 
 



 

 

Fading video and audio
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use
fading simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Open the Tools tab.

Step 3: Set the fade length using the sliders in the General section of the Tools tab

• Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
• Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.

 
To create an audio crossfade, add a fade out to the first clip, and a fade in effect to the second clip.

See also:
Adding transitions
 



 

 

Color adjustments
If the original videos look bleak and not vibrant enough, you can use the automatic adjustments to make the colors look
more vivid. If that isn't enough, you can always use manual adjustments to correct the colors.
 
Step 1: Select clip
On the Timeline, select the clip that you want to adjust.
 
Step 2: Open color adjustments
On the toolbar, click the color adjustments button to open the adjustments in the Tools tab.

Step 3: Use auto adjustments
Under Color Adjustments, select the adjustment options that make the selected clip look nicer. The changes will be applied
instantly.

 
Step 4: (optional) Use manual adjustments
Click the Manual Adjustments button to show more color control options. Here, drag the sliders to fix the brightness,
saturation, hue, and other properties. To go back to the simple options, click the Auto Adjustments button underneath the
sliders.



 

 

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied effects: 



 

 

Crop video
Cropping a video can help you remove black bars, cut away the edges of the video, or permanently zoom in onto an object
inside the frame.
 
Cropping a video or image clip
 
Step 1: On the Timeline, select the clip you want to crop.
 
Step 2: Click the Crop button on the toolbar. The Crop tool will open in the Tools tab, and a cropping frame will appear
inside the player.

Step 3: In the player, set the frame so that the parts you don't want are outside it.

• Drag by the corners of the frame to change its size.
• Drag by the center of the frame to change its position.

 
Be default, the frame will have the same proportions as your project. If you want to change the proportions, deselect the
Constrain proportions option. However, note that black bars may appear around the video after if the video's proportions
are different from the project's.
 
Step 4: Click Apply in the Tools tab. A star icon will appear on the clip once you've applied crop.

Removing crop
To remove Crop or any other Tools effect, do any of the following:

•
Click the star  icon on the clip to show the list of applied effects and filters. In the list, select Crop and click the Remove
button to discard the effect.

• In the Tools tab, you'll see a checkmark next to Crop. Click the circle with the checkmark to remove the effect.

 
 
Cropping all clips
 
Step 1: Open the Edit menu and choose Project Settings to edit your project. The Project Settings window will open.



 

 

 
Step 2: In the Resize Method box, choose Crop.
 
Step 3: Click OK. All the project's clips will be automatically cropped to the project's frame size.



 

 

Rotate and flip clips
Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any vertically-shot photo or video around
without having to crane your neck.
 
Step 1: Select clip
On the Timeline, select the clip you want to rotate.
 
Step 2: Open rotation tools
Click the Rotate button on the toolbar to open the rotation options in the Tools tab. Every time you press the Rotate button,
the selected clips will be rotated it by 90° clockwise.
 
Step 3: Rotate an flip
Click the arrow buttons to rotate the clip clockwise or counterclockwise or flip it along the horizontal or vertical axis. The
changes will be applied instantly. Here, you can also create a cool mirroring effect.

 



 

 

Zooming clips
Using the Zoom tool, you can draw attention to an object inside the frame by magnifying it, or pan a virtual camera across
the frame.
 
Step 1: On the Timeline, select the clip that you want to zoom.
 
Step 2: Click the Tools tab, scroll the tool list down and click the Zoom tool. The Zoom settings will open, and a frame will
appear inside the player. You can use this frame to select which part of the video you want to zoom.

Step 3: On the Tools tab, select the Zoom mode:

• Zoom in-out — the will start at 100%, zooming in on the object, and then zooming back out to 100%.
• Zoom in — the clip will start at 100% and then zoom in on the object until the end of the clip.
• Zoom out — the clip will start already zoomed in, and then slowly zoom out to 100% towards the end of the clip.
• Pan right — this mode uses two frames. The clip will start at the position of the left frame, and then pan to the position of

the right frame.
• Pan down — this mode uses two frames. The clip will start at the position of the upper frame, and then move down, to the

position of the bottom frame.
• Pan and zoom left — this mode uses two frames. The clip will start at 100% (larger frame), and then zoom in to the

smaller frame.

 
Step 4: Set up the zoom level and position using the frames in the player.

• In modes that use one frame, move the frame over the object that you want to zoom.
• In modes with two frames, place the first frame to where you want the clip to start, and the second frame to where you

want the clip to end. During playback, the virtual camera will smoothly move from one frame to the other.



 

 

The size of the frame determines the zoom level, that is, the part of the frame that will be visible at the maximum zoom.
The smaller the frame, the higher the zoom level. If both frames are of the same size, the zoom level will not change. If the
frames have different sizes, the zoom level will smoothly change when moving from one frame to another.
 

Hint:
For best results, use high-definition videos and photos for zooming, since

setting a very high zoom level may lower the quality in zoomed parts.
 
Step 5: In the Zoom section of the Tools tab, click the Apply button. 



 

 

Chroma key
Replacing a video's background

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.
 
Step 1: Add the foreground and background clips
Add the video or image clips that you want to use as the foreground and the background. For the foreground (the clip that
you want to remove the background from), use a clip with a bright, solid background that contrasts with the foreground
objects.
 
Step 2: Create an overlay
1. Select the foreground video and move it up, onto the Overlay track.
2. Double-click the foreground video on the Overlay track. The overlay options will appear above the player.
3. To make the foreground video completely cover the background video, select the Cover overlay mode from the list above
the player.
4. Click Apply.

Step 3: Apply Chroma key
1. Select the foreground video on the Overlay track.
2. Open the Tools tab, scroll to the bottom and click the Chroma Key tool to see its options.
3. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to
remove. The color you've picked will be made transparent, and the underlying video will now be visible.
Tip: if nothing happens when you click on the player, click the color swatch in the Chroma Key options and then try again.



 

 

4. Use the Tolerance slider to set how many similar shades of the selected color should also be removed. Higher values will
remove similar colors to the one you've selected.
5. Use the Noise level slider to determine how sharp the object's edges should be.
6. Finally, click Apply to accept the changes.

Cropping the video
If the videos you're using for the foreground and background have different aspect ratios, you may end up with black bars
along the edges after applying Chroma key. To fix this, crop the videos to the project's aspect ratio.
How to remove black bars
Cropping videos
 



 

 

Highlight and conceal
Using the Highlight and Conceal tool, you can control the focus in the frame, and blur or darken select parts of the video.
 
Step 1: On the Timeline, select the clip that you want to edit.
 
Step 2: Click the Tools button, scroll down, and click the Highlight and Conceal tool. The tool's options will open, and a
frame will appear in the player.

Step 3: In the Highlight and Conceal tool options, select a mode that suits your needs:

• Conceal — blurs or darkens the area inside the frame.
• Highlight — blurs or darkens the area outside the frame, drawing attention to the object within the frame. 

• Outline — like 'Highlight' mode, the area outside the frame is blurred or darkened, and the frame itself is outlined.
• Soft focus — the edges of the frame are much softer than other modes, simulating a camera's focus.



 

 

Step 4: Choose how you want to highlight or conceal the object: using a rectangle or an ellipse, blurring or darkening. Set
the Transparency level to change the effect intensity.

Step 5: In the player, move the frame over the object that you want to highlight or conceal.

Step 6: On the Tools tab, click Apply under Highlight and Conceal options.



 

 



 

 

Stabilizing video
If you're filming with a handheld camera, it's likely that there might be some unwanted camera shake visible on the video,
especially if you walk or move while filming.
 
Step 1: On the Timeline, select the clip you need to stabilize.
 
Step 2: Open the Tools tab. Scroll down and click the Stabilize tool.

Step 3: Under Stabilize, click Apply to start stabilizing the selected clip. This may take a couple minutes for large clips.

Stabilized copies
A stabilized copy of the file will be created under \My Videos\Movavi Screen Capture Studio\Stabilized. This copy will be
used in the project instead of the original video. If you delete the stabilized copy, it will be replaced with the original video,
and you will need to stabilize the clip again.
 
Filming tips:

• When shooting videos, try to rest the camera on something.
• If possible, use a tripod. Some tripods are really small and can fit into your bag.
• If you can't put down the camera, hold it with both hands and close to your body. This will minimize the shaking.
• Try to move around less. If you have to move the camera, do it slowly.
• Check your camera's settings to see if it has built-in stabilization.



 

 

Editing audio
Add audio
You can add audio the same way as you would add video and images: on the Import tab, click the Add Media Files button
and choose the audio files you want to use. If you don't have suitable audio files you can use free music themes from the
Sample audio collection.
Learn more about adding audio

Audio tracks
The Timeline consists of video and audio tracks for each type of media. There are two types of audio track: linked audio and
independent audio.
 
Linked audio clips, located on the upper audio track, allow you to 'attach' sound to a point on a video clip, so that when
you move or split the video, the audio will also be moved and split with the video. This is especially useful if you're adding a
voice-over and want it to stay synchronized to the video throughout the editing process. To link an audio clip to video, drag
an audio clip up towards the video clip you want to attach it to, and align the beginning of the audio with the place on the
video clip when you want the audio to start. A blue line will connect the video clip to its linked audio.
 
Independent audio clips stay on the lowermost audio track, and play independent from any other tracks. For example, you
can place a background music clip on this track, and it will play throughout the project. By default, all new audio files will be
added as independent audio.
Learn more about audio tracks

Extract audio from video
When you add a video to your project, both the video and its soundtrack will be located on the video track. The soundtrack
is shown as a line underneath the video track. To separate the audio from its video clip, drag-and-drop the audio down to the
independent audio track. You've just extracted the soundtrack from a video file! If you don't need the original video, feel free
to delete it from the timeline by pressing the Delete key on your keyboard. Don't worry, the audio will remain where you've
put it.



 

 

Set volume levels
You can set volume levels independently for each video and audio clip.
1. Select the clip that you want to edit.
2. Open the Tools tab.
3. In the General tools, drag the Volume slider to set the necessary volume where 100% is the volume of the original clip.

Split audio
You can cut and split audio clips the same way as you would work with video. To split an audio clip into two parts:
1. Select the audio clip you want to split
2. Move the position marker to where you want to cut the video.
3. Click the Split button (scissors icon) on the toolbar and the audio will be split into two parts.

Loop audio
If the background music ends before your movie does, you can loop the music clip to continue playing until the end:
1. Copy the music clip.
2. Paste it onto the audio track nearby as many times as necessary, until the music is as long as the video. Make sure that
the clips are aligned side-by-side and do not overlap.



 

 

3. Now, the last looped clip is probably longer than the video. To trim it from the end, drag the rightmost edge of the audio
clip to the left, so that the audio clip ends when you want it to.
 



 

 

Adding audio
You can add audio files in much the same way as you add video files.
 
Add files from your hard drive
1. On the Import tab, click Add Media Files to browse for audio files on your computer.
2. A Finder dialog box will open. Choose the files that you want to use.
3. Click Open. The files will be added onto the audio track of the Timeline.

Use sample audio clips
If you don't have any suitable audio files, you can use free sample audio clips[1] from the Movavi Video Editor audio
collection.
1. On the Import tab, click Sample audio to open the free stock audio collection.
2. Click on a clip to hear it. When you've picked a clip, drag it onto the audio track of the Timeline.

Record audio
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the toolbar to open recording options.
4. Set up your recording device and volume.
5. Click Start Recording and record the audio. When you're finished, click Stop Recording. You'll find your new recording
on the Timeline.
Learn more about audio recording



 

 

 
Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as a blue line with a music note icon:

By default, the audio clips will be added to the very beginning of the audio track on the Timeline. To change when the audio
clip starts playing, drag it along the Timeline.
Learn about audio tracks
 

[1] Stock Audio Tracks:
Stock audio tracks are copyright of their respective owners and are free for both personal and commercial use with credit
attribution under the Creative Commons license.
Adventure
"Coulda Shoulda Buddha" by UncleBibby
Available on the Free Music Archive
(freemusicarchive.org) Under CC BY license

Mystic
"Lunar Dunes" by Spinning Clocks
Available on the Free Music Archive
(freemusicarchive.org) Under CC BY license

Romantic
 "The Wrong Way" by Jahzzar
Available on the Free Music Archive
(freemusicarchive.org) Under CC BY-SA license

Travel
"Nobody Here But Us Charles Dickens" by UncleBibby
Available on the Free Music Archive
(freemusicarchive.org) Under CC BY license

 

http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/
http://creativecommons.org/licenses/by/3.0/


 

 

Audio tracks
When you add new audio files, they will be added to the audio track of the Timeline.

Audio clip on the Timeline
There are two kinds of audio track: independent audio track and linked audio track.

Independent audio
The bottom audio track is the independent audio track. Audio clips on this audio track will play independent of any other
clips, which is perfect for background music. By default, all newly added audio clips appear on the independent audio track.
 
Linked audio
The linked audio track appears when you attach an audio clip to a video clip. Linking an audio clip to a video means that the
audio clip will always be synchronized with this video clip, as if it was part of the video file. This is especially useful if you
want to add a voice-over and make sure it stays synchronized with the video as you continue working on the project.
 

•  Linked audio can be 'attached' to any point of a video clip, whenever you want the audio to start.
•  If the linked audio is longer than the video it is attached to, it will keep playing when the video clip ends.
•  If you move the video clip, its linked audio clips will also be moved, without losing sync with the video.
•  If you delete the video clip, the linked audio clips will also be deleted.
•  If you split the video clip, the linked audio clip will also be split into two parts, each linked to the same points of the video

as they were before.

 
To link an audio clip:
1. Drag the audio clip up, towards the video track. The linked audio track will appear – this is where you will need to place
the audio clip.
2. A blue line will appear, connecting the beginning of the audio clip to a point on the video clip. This line marks when the
audio clip will start playing relative to the video clip. Drop the audio clip onto the linked audio track, so that the blue line is at
the point when you want the audio to start.



 

 

Drag the clip up to attach it to a video.
Embedded audio on the video track
Video clips are usually made up of video and audio streams. When you add a video to the Timeline, it will be added to the
video track as a video clip with an audio clip underneath it. Whenever you move or split a video, its audio will also be moved
and split with the video.
 
If you want to edit the video's soundtrack separately, you can detach it from the video clip: drag the audio clip from
underneath the video down onto the independent audio track.

 
 
 
 
Playing audio synchronously
If you want two audio clips to play at the same time, simply drag one clip underneath the other. This way, you can have
as many sub-tracks as you want. With music, you can use this to create a crossfade effect when you join songs: align the
beginning of the second song with the end of the first song to make them joined almost seamlessly.

The end of the first audio clip will be played with the beginning of the second clip.



 

 

Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these
files may be placed on the video track. In that case, drag the audio clip down onto the audio track, and delete the album art
from the video track if you do not need it.
 
 



 

 

Volume levels
Changing volume levels works the same way for video and audio clips:
 
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an audio clip on any track.
 
Step 2: Click the Tools button to open the tools for the selected clip.

Step 3: Drag the Volume slider to set the necessary level, where 100% is the original volume. To mute the clip, drag the
slider down to 0%.

Playback volume
Only for previewing
If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the
speaker icon in the preview area and set the necessary volume level. Please note that this will only affect the volume while
previewing the project in Movavi Video Editor, and will not affect the output file.



 

 

Cutting audio
Splitting audio
1. Select the clip that you want to split.
2. Move the position marker to the point where you want to split the clip.
3. Click the Split button on the toolbar (scissors icon).
The audio clip will now be split into two parts.

Trimming audio
To trim an audio clip from the beginning or from the end, hold your mouse pointer over the left or right edge of the clip and
drag it towards the center. The length of the audio clip on the Timeline reflects the length of the sound.

Cutting out parts
Let's say you want to cut out a fragment from the middle of an audio clip. This is done the same way as splitting video and
audio, except that you will need to split the clip twice.
 
1. Split the audio clip at the beginning of the unwanted fragment. To do that:

1.1 Select the clip you want to cut.
1.2 Find the beginning of the unwanted fragment and move the position marker there.
1.3 Click the Split button on the toolbar (scissors icon).

This will split the clip into two parts, with the unwanted fragment located in the beginning of the second clip.
 
2. Split the audio clip at the end of the unwanted fragment. To do that:

2.1 Select the second clip.
2.2 Find the end of the unwanted fragment and move the position marker there. 
2.3  Click the Split button again.

The fragment is now located in a separate clip.
 
3. Now, select the clip with the unwanted fragment and press the Delete key on your keyboard. The clip will be removed,
and the remaining clips will be moved up to close the gap.

For more precise navigation:

• Use the arrow keys to jump to the beginning of the previous or next clip on the Timeline.
• Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to

jump half a second forward or back.
• Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: ⌥⌥←

and ⌥⌥→.
• Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the ⌥← and ⌥→

keyboard shortcuts.



 

 



 

 

Looping audio
If the music file you've selected doesn't go all the way until the end of your movie, you can loop the audio and have the file
play over again until the end of the video.
 
1. Copy the audio clip. To do that, control-click the audio clip on the Timeline, and choose Copy from the pop-up menu, or
use the ⌥+C keys.
2. Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker.
Repeat until the audio is as long as the video.
3. Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of
the clip, and drag the edge to the left, until the end of the audio clip is right under the end of the video clip.

 



 

 

Extracting audio from videos
If you want to use a soundtrack from a movie, you can extract it from a video file and use it in your project. 
 
Step 1: Open video file
On the Import tab, click Add Media Files and choose the video that contains the music you want. The file will be added to
the video track of the Timeline.

Step 2: Trim video
If you don't need the whole video's soundtrack, you can trim away the parts of the video you won't need. It's easier to do this
with the video file, as the video can help you visually find the beginning and end of the fragment you need.
1. Select the video you want to trim.
2. Move the position marker to the beginning of the fragment you want to keep and click the Split button on the toolbar
(scissors). You've just cut off the beginning of the video. 
3. Now, select the second clip and move the position marker to the end of the fragment you need. Click the Split button
again, and the fragment will now be in a separate clip.
4. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete
them.

Step 3: Extract the video
The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the
audio stripe down onto the audio track. If you don't need the video clip anymore, go ahead and delete it.



 

 

You can now work on the extracted audio clip.
 
Step 4: Save the audio (optional)
If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button. The export window will open.
2. In the Export window, switch to the Save Only Audio tab.
3. Select an audio format that you want to save the audio file in.
4. The Save to field shows where on the disk the file will be saved. To change that folder, click Browse and select a new
folder.
5. Finally, click Start to save the audio file.
 

Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.



 

 

Adding titles
Adding text titles to your movie allows you to express your thoughts and supplement the audio with subtitles.
 
Step 1: Go to the Titles tab
On the left-hand side of the window, click the Titles button to view the titles collection. Click on a title style's thumbnail to
preview its looks in the player and choose the titles you want to use.

Step 2: Add a titles clip
To add titles to your project, pick a title style you like and drag its thumbnail onto the title track of the Timeline, right above
the video track. A title track will appear above the video track: drop the titles here, onto the time where you want them to
appear. The titles will appear as a purple ribbon on the Timeline.
 
The beginning of each title clip is linked to a corresponding video clip on the video track. This way, whenever you move or
edit the video clip, its titles will always stay in sync.

If you already have a titles clip on the Timeline, you can add another clip onto the same timeframe to make them play
simultaneously: simply place one title clip under another.
 
Step 3: Edit titles
When you've added a title clip, it will start out with the default text and looks. Double-click the title's ribbon on the Timeline to
show editing options in the player.
 
Title clip properties



 

 

Click the cogwheel icon  at the top of the editing panel to see title clip properties. Here, you can change the duration of
the titles and animation speed (how fast they will appear or disappear).
 
Editing text
1. In the preview, double-click on the text box you want to edit.
 
2. Enter the new text.

3. Click the Font properties  button and select the font style, size, and alignment options for the selected text.

4. Click the Color properties  button and choose a color for the text, and the outline's width and color.
 
5. Drag the text box to where you want to see it on the video.
 
Editing decoration elements
Some titles come with frames, ribbons, and other decorations. To change their color, select the decoration element you want

to edit and click the Color properties  button. Then, click the Decorations color palette and choose the new color.
 
Finally, click Apply to exit editing mode.



 

 

Adding transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way.
 
Add a transition
1. Click the Transitions button in the upper left-hand corner of the window to open the list of all transitions.
 

Click to open the Transitions tab.
2. In the list of transitions, pick a style you like and drag-and-drop its icon between to clips on the Timeline.
 

A transition icon will appear between the two clips.

Change transition length
By default, each transition will be set at 2 seconds long. To change the transition length:
1. Double-click a transition on the Timeline to open transition properties.



 

 

2. In the Transition Properties window, enter the new transition length in the Duration field. The format is
hours:minutes:seconds:milliseconds.
If you want all transitions that are currently in the project to have the same length, select the Set this duration for all
transitions option.
3. Click OK to apply the changes.
 

 
Add transitions to all clips
You can automatically add transitions between all clips in your movie in just a few steps:
1. Click the slideshow button on the toolbar. The Create Slideshow dialog box will open.
2. In the Create Slideshow dialog box, select a transition style that you want to use for all clips. If you want to use different
transitions, use the Random Transitions option in the list of transitions.
3. In the Transition duration box, enter the length that you want to set for all transitions. A transition cannot be longer than
the shortest clip in your project.
4. Click OK to accept the changes.
 

Remove a transition
To remove a transition from your movie or slideshow, control-click the transition on the Timeline and choose Remove
Transition from the pop-up menu. If you want to delete all the transitions in your project, choose Remove All Transitions.
 



 

 



 

 

Creating slideshows
With Movavi Video Editor module, you can easily create a slideshow in just a few simple steps:
 
Step 1: Add videos and photos
On the Import tab under the My files section, click Add Folder in the My files section to add the contents of an entire folder
(for example, all your vacation photos!) or click Add Media Files to add individual files.
Adding media files

Step 2: Add transitions and set slide duration
Now that you've added the media files, they will appear on the Timeline. Now it's time to set the length of each slide and join
them with interesting transitions.
1. Click the Slideshow button.
2. In the Create Slideshow dialog box, select a transition style that you want to use for the slideshow. If you want to use
different transitions, choose the Random Transitions option.
3. In the Image slide duration field, enter how long you want each slide to be shown on screen. The format is
hours:minutes:seconds:milliseconds for both transitions and slides.
4. In the Transition duration field, enter the length for all transitions. Transition length cannot exceed slide length.
5. Click OK to accept the changes and add the transitions.
 
If you want to change individual transitions, go to the Transitions tab and drag the transition you want in between two clips
on the Timeline.
Learn more about transitions



 

 

Step 3: Add background music
To add music, go back to the Import tab and click the Add Media Files button to choose a background audio file. If you
don't have suitable audio files on your computer, you can use one of our sample music tracks: click Sample audio on the
Import tab to open the stock audio collection and drag an audio sample onto the Timeline.
Learn more about adding music
Learn more about working with audio
 
Step 4: Add titles
To add text to your slideshow:
1. Go to the Titles tab.
2. Drag a text style you like onto the top of the Timeline and drop it onto the titles track.
3. Double-click the titles ribbon to edit the clip.
4. In the player, enter your text and set up the font and color options.
5. Click Apply on the options panel to accept the changes.
Learn more about adding titles

Step 5: Save your slideshow
Finally, it's time to save your slideshow.
1. Click the Export button in the bottom right-hand corner of the window.

2. In the Save as Video tab of the Export window, choose the format that you want to save the video in. This will affect
video quality and file size.



 

 

3. The Save to box shows where the video file will be saved to. If you want to choose a different location, click Browse.
After that, name your slideshow in the File Name box.
4. Click Start to begin processing your slideshow! This may take up to a few minutes, depending on the size of your
slideshow.



 

 

How to remove black bars
Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black
bars around them. This can be fixed by adjusting the project settings, so that they fill up the whole frame.

 
Some clips have black bars around them
If some videos or photos have black bars around them, it is most likely that they have a different aspect ratio from that
defined in the project settings. For example, even videos and photos shot with the same camera may differ in width and
height, so that when you place them side by side, one of them may end up with black bars. To fix this, you can crop away the
edges of those clips, so that they fill the entire frame:
 
1. Beneath the Timeline, find the Project settings information and click the pencil icon next to it to open the project settings
window.

2. Open the Resize Method box and select Crop from the list.
3. Click OK.



 

 

All clips have black bars around them
If all of the clips have black bars around them, then it's a good idea to change the aspect ratio of the project to match that of
the clips you are using.
 
1. First, you'll need to find out the size of the videos you are using, so that you can match it in project settings. To do that,
control-click a clip on the Timeline and choose File Information from the pop-up menu. Here, note the width x height size
of the frame (e.g. 1920x1080) and the aspect ratio (e.g. 16:9).

Now we'll need to set the project settings to the same frame size.
 
2. Beneath the Timeline, find the Project settings information and click the pencil icon next to it to open the project settings
window.



 

 

3. Under Frame Size, choose the frame size with the same aspect ratio as your videos. If you can't find it in the list, you can
manually input the frame size into the boxes below.
4. Click OK to accept the changes. The clips should now nicely fit inside the frame without any black bars.

 
 



 

 

Exporting Videos
When you're done with your project, you'll need to export it as a media file to be able to play it back in media players, mobile
devices, and so on. This section will guide you through the process of exporting your project to a popular video format. If you
want to find out more about other ways of saving videos, see the following guides:
Saving only audio
Saving videos for devices
Saving videos for uploading online
 
Step 1: Open the Export window
To start saving the video, click the Export button in the bottom right-hand corner of the Editor. The export settings window
will open.

Step 2: Choose a format
Open the list at the top of the window and choose a format for saving the video in.  Some formats allow you to choose which
video codec you want to use, and some allow you to save 60 FPS video*.
*The video file will have a frame rate of 60 FPS only if the original video files used in the projects had a frame rate of 60 FPS
and above.
 
If you don't know which format to choose, try using MOV or MP4 with the H.264 codec. MOV format is natively supported
by all Macs and Apple devices, while MP4 can be played on most platforms and operating systems.

Step 3: Check your project settings
When saving standard video, the video will be exported with the same settings that were set for the project. This way, the
output video will appear exactly as you have seen it in the preview area. If you want to change the resolution, aspect ratio, or
other settings, click the pencil icon to view and edit the project settings.



 

 

 
The Estimated File Size field shows how much disc space your file will require after saving. If the file size is too large, you
can set a lower resolution in the Project Settings. At lower resolutions, the file will be significantly smaller, however the video
will lose some quality due to the limitations of digital data compression. When changing resolutions, we recommend that you
keep the same aspect ratio to avoid black bars around the video or other unwanted distortions.
Learn more about project settings
 
If you don't know which format to choose, try using MP4 with the H.264 codec. The MP4 format is supported by most
platforms and operating systems.
Learn more about formats and codecs

Step 4: Select quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a
higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will
provide a nice result at a small file size.

 
Step 5: Choose a destination folder
Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving
output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the
Finder window, or enter the path manually into the box. Name your video in the File Name field: the project's name will be
filled in for you by default.

Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.



 

 



 

 

Export only audio
This section will guide you through exporting just the audio track of your project.
 
Step 1: Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

Step 2: At the top of the Export window you will find a number of tabs. Click on the Save Only Audio tab

Step 3: Open the list at the top of the tab and select the format you'd like to save the audio in.
 
While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to
preserve high audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important
to note the quality of the original files: due to data compression limitations, digital audio cannot be restructured from very low
quality files by saving them as FLAC audio, and vice versa – high quality files may lose some of that quality when saved to
MP3 format which is limited to 320 Kbps.
 
Step 4: When saving audio from your project, the audio file will retain the same sample rate and channel settings as you
have set for your project. The audio bitrate will be determined from the quality of the original files and from the maximum
bitrate for the selected format (for example, MP3 is limited to 320 Kbps, while FLAC bitrate is not limited).
Learn more about formats and bitrate
 
Step 5: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving
output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the
Finder window, or enter the path manually into the box. Name your video in the File Name field: the project's name will be
filled in for you by default.



 

 

 
Step 6: Click the Start button at the bottom of the window to begin processing the video file. This may take up to a few
minutes. 

 



 

 

Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, TVs, and other devices.
 
Step 1: In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: At the top of the Export window, you will find a number of tabs for saving different kinds of media. Choose the
necessary tab depending on your type of device:

• For Apple Devices: to save the video for devices made by Apple, including iPhones, iPads, iPods and Apple TV.
• For Android Devices: to save the video for smartphones, tablets, and other devices running the Android operating

system.
• For Other Devices: to save the video for devices running neither iOS nor Android. These include Blackberry and Nokia

smartphones, classic mobile phones with 3GP and 3G2 video, Xbox, PlayStation, Zune, and others.

Step 3: Once you've opened the necessary tab, open the list at the top and select your device or manufacturer from the list.
 
Note the Export Settings information, where you can view the properties for the output file. Due to the limitations of some
devices, the video resolution, audio quality, and other properties may be changed to adhere to the requirements of the
selected device. Estimated File Size will give you a rough estimate of how much disk space the file will occupy, which may
be important if your device is running out of memory.
 
Step 4: Set export quality (optional).



 

 

If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a
higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will
provide a nice result at a small file size.
 
Step 5: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving
output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the
Finder window, or enter the path manually into the box. Name your video in the File Name field: the project's name will be
filled in for you by default.
 
Step 6: Click the Start button at the bottom of the window to begin processing the video file. This may take up to a few
minutes. 



 

 

Export online
Movavi Video Editor can help you prepare your video project for uploading it to YouTube and other video hosting sites.
 
Step 1: When your project is complete, click the Export button in the bottom right hand corner of the Editor to open the
exporting window.

Step 2: The upper part of the Export window contains a row of tabs. Click For Uploading Online to open the list of relevant
settings.

Step 3: Open the list at the top of the tab and choose a suitable format for saving your video.
 
For YouTube and other video sharing websites:
If you want to upload the video to a video hosting website, such as YouTube, you can simply choose one of the available
presets, such as YouTube - 720p. For some, you can choose to save the video in a variety of resolutions: for example, you
can choose HD or standard-definition video when saving for Vimeo. However, if the original videos are of HD quality, we
recommend that you choose a higher resolution, as the video sharing service will automatically create a lower-resolution
copy of your video for low-bandwidth viewers.
 
Please note that some video sharing websites, such as Vimeo, limit HD video uploads for different types of accounts. We
advise you to check the website's upload restrictions, as well as any copyright policies, and to make sure that you have the
right to publish the videos in question under copyright laws and your country's law.
YouTube Help – Increasing your upload limit
Vimeo FAQ
 
For your own website or web storage:

https://support.google.com/youtube/answer/71673?hl=en
http://vimeo.com/help/faq


 

 

At the bottom of the list, you can find a number of web-ready formats. Choose the one that best fits your upload
requirements. You can also embed YouTube videos into your blog or website: simply save your video using one of the
YouTube options, upload the video to your YouTube account, go to your video's page and then click Share, and go to the
Embed tab. YouTube will give you an HTML5 embed link for your video that you can use in your website or blog.
 
Note the Export Settings section, where you can see the properties that your output video will be saved with. These
properties are defined by the selected format, resolution, or the requirements of the chosen video sharing website.
 
Step 4: Select video quality (optional).
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a
higher bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will
provide a nice result at a small file size.
 
Step 5: Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving
output videos specified in the preferences. To set a different folder, click the Browse button and choose the folder in the
Finder window, or enter the path manually into the box. Name your video in the File Name field: the project's name will be
filled in for you by default.
 
Step 6: Click the Start button at the bottom of the window to begin processing the video file. This may take up to a few
minutes. 

 
 



 

 

Saving and opening projects
A project stores all the work on your movie or slideshow. You can save the project for finishing your work later, or restore
your work if you need to edit something after you've finished.
 
Saving the project
1. Open the File menu and choose Save Project.
2. You will be asked to enter a name for the project. Your project files should be stored in the /Movies/Movavi Video Editor/
Projects folder of your user. 
3. Click Save to confirm saving.

Later, you can open this project to continue working on your project.
 
Opening a project
1. Open the File menu and choose Open Project.
2. Locate the project file.
3. Click Open in the dialog box.
 
You can now resume your work on the project.
 

See also:
Finding missing files
Project settings
Exporting videos
 
 
 
 



 

 

Finding missing files
When you open a previously created project, you may see a message saying that a file is missing from the project. This may
happen if one of the files used in the project has been moved somewhere else or deleted from disk. 

 

• If the file was moved elsewhere, click the Browse button and locate the file in the Finder window. After that, you can
continue working on the project as usual: the file will be restored in its place on the timeline, as well as any other changes
you have made.

• If the file was deleted or you no longer wish to use it in the project, click Skip to open the project without the missing file.
• To cancel loading the project, click Cancel. 

Why is this happening?
In order to save disk space, Movavi Video Editor does not copy the files you add to the project, but rather remembers their
location on disk. Therefore, if you move or delete the original files, it will no longer be able to use them as reference.
 
Where should I store the original files?
We recommend you to store the original photos and videos for your projects in the User/Movies folder.



 

 

Project Settings
You can set up your project's video and audio settings both when creating the project and at any other time.
 
Opening Project Settings
When creating a project:
When you create a new project or launch Movavi Video Editor, you will see a small window where you can choose an aspect
ratio for your project. Click Advanced Settings to show more video and audio settings.

During editing:

• On the bottom panel of Movavi Video Editor, find the pencil icon next to the information about your project. 
• Open the Edit menu and choose Project Settings.

 
Video Settings
The video settings apply to all videos and photos used in the project. When you import the media files, they will be scaled to
fit inside the selected frame size according to your settings. 
 
Frame size
The frame size or resolution determines the videos width and height in pixels. Open the Frame Size list to select from the
most common resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the
frame size should match the resolution of the videos and photos you plan to use in your project, and should not exceed
the resolution of the largest video. Smaller resolutions allow you to make the output video smaller and thus save your disc
space, however, this will sacrifice some video quality due to downscaling.

Frame Size Aspect Ratio
320x240 4:3
640x480 4:3

1280x720 16:9

1280x960 4:3
1920x1080 16:9
1920x1440 4:3



 

 

Aspect ratio
The aspect ratio is the ratio of the video or photo's width to its height. The most commonly used aspect ratios are 4:3, used
generally for analog TV and in many old movies, and 16:9, the standard resolution for widescreen digital video.

A relative comparison of aspect ratios
 

When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with
an aspect ratio different from that of the project, you may see black bars appear on the sides of the video. Furthermore, if
you add low-quality videos to a project set up to a high resolution (frame size), the small video may be stretched to fit the
frame and thus may appear pixellized. For best results, we recommend setting the frame size and aspect ratio to match all
or most of the videos and photos you are planning to use.

 
Examples of black bars appearing when importing videos with a different aspect ratio.

 
If you cannot find the necessary frame size in the list, you can manually enter the width and height into the respective boxes
of the Project Settings window. Note the button with the link icon to the right of the boxes. It allows you to maintain existing

proportions when entering new values:   – the proportions are constrained, allowing you to set a larger or smaller frame

size without changing the aspect ratio;  – you can freely enter the width and height with any proportions. Simply click this
button to toggle the two states.
 
Resize method
Choosing a resize method can help you manage how all of your videos and photos are resized to fit inside the frame size
you've set. This is especially important when the aspect ratio of some videos and photos does not match the aspect ratio of
the project and you need to get rid of the black bars. There are three resizing options available:
 
Letterbox – the video will be resized to fit inside the frame entirely. This method allows you to keep the whole video inside
the frame without distortions, but may place black bars around the video.



 

 

Stretch – the video is fit entirely inside the frame and then stretched on one axis in such a way as to fill the entire frame
without leaving black bars. This allows you to cover the entire frame, however, the objects in the video may appear
horizontally or vertically distorted.

Crop – the video will be resized to be slightly larger than the frame, cropping the parts that do not fit inside it. This allows
to cover the entire area of the frame without distorting any of the objects inside the video or without leaving black bars,
however, this may not suit some clips where important objects are near the edge of the frame.

Audio Settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain.
The default sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to
record Audio CDs and most music tracks.
 
Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes
it best for recording music; mono sound has only one channel and produces sound without differentiating left and right
channels. Stereo is the generally preferred number of channels, however, some mobile devices record sound only in mono
mode.
 
File properties
To open a file's properties, control-click it on the storyboard and choose File Information from the context menu. Knowing
certain information about a clip will allow you to better understand which settings are best for your videos.



 

 

A small File Information window will appear. Here, you can find out the video or image's resolution, aspect ratio, and
other properties.
 

 

See also:
Creating new project
Saving and opening projects
 



 

 

Editor Preferences
To open the preferences, click the Movavi Video Editor application menu and select Preferences.

Interface Language – to change the interface language, simply select the necessary language from the list and click OK to
apply the changes.
 
Directory for project files – this folder will by offered by default when saving and opening projects. This folder will also
store any autosave files for new projects. You can use the autosave to restore your work in case of an error or force close.
The default folder is /Movies/Movavi Video Editor/Projects.
 
Directory for saving output videos – this folder will be offered by default when exporting media files. The default folder is /
Movies/Movavi Video Editor/.
 
Directory for audio recordings – the audio clips that you record in the Editor will be stored as audio files in this folder. Tip:
if you delete these audio files, the audio recordings in the project will also be unavailable.
 
Directory for stabilized files – when you stabilize a video, a stabilized copy of the original will be created in this folder and
used instead of the original. Tip: don't delete these files while you are working on the project, or you'll have to stabilize the
files again.
 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates
within your version are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered
users.
 
Send anonymous usage stats to Movavi – checking this box will allow Movavi Video Editor to send usage statistics to our
development team, enabling us to fix any bugs you may encounter much faster, as well as add new features that you might



 

 

be missing. The data sent by Movavi Video Converter contains no personal information, will not be disclosed to third parties
and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Show project settings window when creating new project – with this option enabled, you will be prompted to select
settings for the new project on startup and when creating new projects. You can choose the project's aspect ratio and other
settings, as well as open an existing project.
 
When you're done, click OK to close the window and apply the preferences.
 

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html


 

 

Help and support
If you have any questions or concerns regarding Movavi software, you are welcome to contact our support team.
 
Write to us at support@movavi.com
Or click the button on the right to ask a support specialist via live chat.
 
Please describe your problem in as much detail as possible; any screenshots or log files will allow us to help you faster. Our
support team specialists may ask you for additional information that is required to solve your problem: these may include
your license key, log files, and files you were working with, but never personal information. We value your privacy!
 

Have you checked the FAQ section?
Your question may have already been answered!

Frequently asked questions:
How to remove trial restrictions?
Why do my videos have "trial version" on them?
What are the system requirements for running Movavi Screen Capture Studio?
What formats can I save my videos in?

mailto:support@movavi.com
http://www.movavi.com/support/#sales


 

 

System Requirements
 Minimum system requirements Recommended system requirements
Операционная система Mac OS X 10.6, 10.7, 10.8, 10.9, 10.10 and higher
Процессор Intel processor
Разрешение экрана 1024x768 screen resolution 1280x1024 or higher resolution

Оперативная память 256 MB RAM 1 GB RAM
200 MB available space on hard disk 
for installation

200 MB available space on hard disk  for
installation

Свободное место на диске

1 GB available hard disk space for ongoing operations*
 Administrator permissions are required for installation
 
* The free space on a hard disk is needed for keeping temporary files during capture and for storing recorded videos. The
space needed could vary depending on the size of capture area, screen resolution, format and length of recorded videos.
 
Movavi Screen Capture Studio may also run on slower machines, however, we cannot guarantee stable performance if the
minimum requirements are not met.



 

 

Input formats
 
Movavi Video Editor
These are the formats that you can use for input and output in the included video editing app:

 
Video Formats

 
Supported Codecs

Read / Write H.263
3GPP (.3gp), 3GPP2 (.3g2)

Read Only H.264, MPEG-4
Advanced Streaming Format (.asf) Read Only MPEG-4, VC-1, WMV V7

Read / Write H.264, MPEG-4

Audio Video Interleave (.avi) Read Only H.263, MJPEG, DivX, Xvid, DV,
Cinepack, Fraps, TechSmith,
Uncompressed

DivX Video (.divx) Read Only DivX
Read / Write H.264

Flash (.flv)
Read Only FLV1, H.263, Flash Screen Video

Read / Write FLV1
Flash (.swf)

Read Only MJPEG
HD-video
(.m2ts, .mkv, .mov, .mp4, .mpg, .wmv)

Read / Write MPEG-2, MPEG-4, H.264, WMV V8

HD-video (.m2t, .mts, .ts, .wmv) Read Only MPEG-2, MPEG-4, H.264, AVCHD,WMV
9, WMV 9 Advanced profile

Read / Write H.264
Matroska (.mkv) Read Only MPEG-4, MJPEG, Theora, DV,

Uncompressed
MPEG Transport Stream (.m2ts) Read / Write H.264

MPEG Transport Stream (.ts, .mts, .m2t) Read Only MPEG-2, H.264

MPEG (.mpg) Read / Write MPEG-1, MPEG-2

MPEG (.mpeg, .mpe, .m1v, .mod, .tod) Read Only MPEG-1, MPEG-2, H.264

Read / Write MPEG-4, H.264
MPEG-4 (.mp4) Read Only H.263, MJPEG, ProRes

MPEG-4 (.m4v) Read Only MPEG-4, H.264, H.263, MJPEG, ProRes
MXF – Material eXchange Format (.mxf) Read Only MPEG-2, DV

Read / Write Theora
OGV – Ogg Video (.ogv)

Read Only MPEG-4
Read / Write H.264

QuickTime (.mov) Read Only MPEG-4, AIC, MJPEG, ProRes,
Sorenson 1/3, PNG

QuickTime (.qt) Read Only H.264, MPEG-4, AIC, MJPEG, ProRes,
Sorenson 1/3

RM – RealMedia (.rm, .rmvb) Read Only Real Video 2/3/4, Cooker
Read / Write VP8

WebM (.webm)
Read Only VP7, VP9

Read / Write WMV V8

WMV – Windows Media Video (.wmv) Read Only WMV V7, WMV 9, WMV 9 Screen,WMV
9 Advanced profile, MPEG-4,WMV 9.1
Image V2

WTV – Windows Recorded TV Show
(.wtv)

Read Only H.264, MPEG-2

  



 

 

Audio Formats Supported Codecs
AAC – Advanced Audio Coding (.aac) Read / Write AAC
AMR – Adaptive Multi-Rate audio codec
(.amr, .3ga)

Read Only AMR

AIFF – Audio Interchange File Format
(.aif,.aiff)

Read Only Uncompressed

APE – Monkey's Audio (.ape) Read Only Monkey's Audio
Au (.au, .snd) Read Only PCM
FLAC – Free Lossless Audio Codec
(.flac)

Read / Write FLAC

MP3 – MPEG-1/2 Audio Layer III (.mp3) Read / Write MP3

MPEG-4 (.m4a, .m4b) Read / Write AAC
MPEG-4 (.m4a, .m4b) Read Only AAC, PCM, ALAC
OGG – Ogg Audio (.ogg) Read / Write Vorbis

Read / Write PCMWAV – Waveform Audio File Format
(.wav)

Read Only AAC, MP3
Read / Write WMA 9WMA – Windows Media Audio (.wma)

Read Only WMA Pro, WMA Voice
 

Image Formats
 

Supported Codecs
BMP (.bmp) Read Only BMP
DPX (.dpx) Read Only DPX
GIF (.gif) Read Only GIF

JPEG (.jpg. jpg, .jp2, .jls) Read Only MJPEG, JPEG2000, JPEGLS
Netpbm formats
(.pgm, .pbm, .ppm, .pam)

Read Only PGM, PBM, PPM, PAM, PGMYUV

PCX (.pcx) Read Only PCX
PNG (.png) Read Only PNG
PTX (.ptx) Read Only PTX
SGI (.sgi) Read Only SGI
TARGA (.tga) Read Only TARGA
XBM (.xbm) Read Only XBM
XWD (.xwd) Read Only XWD
 



 

 

Output formats
Movavi Screen Capture Studio
These are the formats that you can export your video in with Movavi Screen Capture Studio:

 
Video Formats

 
Supported Codecs

3GPP (.3gp), 3GPP2 (.3g2) H.263, H.264, MPEG-4

Audio Video Interleave (.avi) H.264, MPEG-4, MJPEG
Flash (.flv) FLV1, H.264
Flash (.swf) FLV1
Matroska (.mkv) H.264, MPEG-4, MJPEG, Theora
MPEG Transport Stream (.m2ts) MPEG-2, H.264
MPEG-4 (.mp4) MPEG-4, H.264
OGV – Ogg Video (.ogv) Theora
QuickTime (.mov) H.264, MPEG-4

WebM (.webm) VP8

WMV – Windows Media Video (.wmv) WMV V8
 

Audio Formats
 

Supported Codecs
AAC – Advanced Audio Coding (.aac) AAC
FLAC – Free Lossless Audio Codec (.flac) FLAC
MP3 – MPEG-1/2 Audio Layer III (.mp3) MP3
OGG – Ogg Audio (.ogg) Vorbis
WAV – Waveform Audio File Format (.wav) PCM

WMA – Windows Media Audio (.wma) WMA 9
 
You can check detailed instruction in Saving video section.



 

 

Glossary
The following is a list of some terms that you may come across while working with video and audio. You won't need to know
all of these to use Movavi software, but if you want to learn more about the specifics of media file processing, you can start
here.
General
Aspect Ratio
A video's aspect ratio is the ratio of a video's width to its height in pixels. The two most frequently used aspect ratios are 4:3
and 16:9. The former is used by most analog television broadcasts, while the latter, also referred to as widescreen – in films,
DVDs, and modern HD video. When the aspect ratios of your screen and a video do not match, you may notice black bars
on two sides of the video.
 
Container Format (Video Format)
A container format is a file format for storing video or audio files that contains video and audio data in separate streams,
as well as any other associated data, such as subtitle tracks and additional data about the file. You can think of a container
format as a box that holds together all the parts that make up a video file, as illustrated below. The container format is what
you usually see when you work with video files: you can judge which format your video is in by the file extension: *.mp4
corresponds to MP4 format, *.mkv to Matroska format, etc.
 

Codec
While a video file contains video and audio streams, these streams are in turn encoded using a video or audio codec that
compresses the data. You can think of a codec as a language: to play a video encoded with a certain codec, your player
needs to be able to 'understand' how it was encoded, so that it can decode or decipher the file. If your computer does
not know how to decode a new codec, you can fix this by converting the file to a different format or by installing a codec
pack. However, please keep in mind that a lot of malware programs disguise themselves as codec packs; you should only
download codec packs directly from codec manufacturers or from trusted sources.
 
Bitrate
When referring to media, bitrate is the number of bits that is played back each second. The higher the bitrate, the more
details that can be conveyed with each second of the video or audio stream, and therefore, the higher the quality. There are
two types of bitrate: constant bitrate (CBR) and variable bitrate (VBR). Videos with constant bitrate, as you can probably
guess from the name, have the same bitrate for each and every frame of the video, no matter the complexity of the frame:
simple frames, for example, those completely filled with black, have the same number of bits as complex, colorful frames.
This has a number of limitations, since the simple frames take up more bits than needed to convey them, while complex
frames are limited in quality. With variable bitrate, however, each frame is allotted only as many bits as it needs, without
limiting quality or wasting data. In most cases, we recommend that you use variable bitrate, however, you CBR is sometimes
useful for streaming media.
 
Frame Rate
The frame rate, or frames per second (FPS) is the number of video frames that is contained in a second of video. At low
frame rates, you may notice that the video is 'jittery', while higher frame rates produce a smooth high-quality video. Shooting
videos at high frame rates (48 or 60 FPS) requires more resources and disc space, but you can easily slow down a high-
FPS video to produce a slow-motion effect without producing visual stutter. The industry standard for cinema frame rate is 24
or 25 frames per second, which is perceived as comfortable to the human eye.



 

 

 
Interlaced Video, Deinterlacing Video
Video interlacing is a method used in traditional analogue video broadcasting that arose due to the limitations of early
television. Each frame of the video is split into half-frames, each frame containing even and odd rows consecutively. This
allows to broadcast at double the frame rate, producing a seemingly smoother video stream, while the eye does not notice
the missing rows. However, on digital displays, interlaced video may produce visible defects in the form of horizontal
lines. Deinterlacing helps remove these defects using algorythms by merging the two half-frames into one. Movavi Video
Converter automatically deinterlaces output videos.
 
Remuxing
Many container formats support a number of common codecs, such as H.264, which can be stored in MP4, AVI, M2TS,
MKV, MOV, and other formats. When you convert a video that is encoded with a codec supported by both the input and
output container formats, you can simply transfer the video stream from one container format to another, without having to
re-encode it. This process is called remuxing and it allows you to save a lot of time, since video re-encoding is the longest
part of the conversion process.
 
Resolution (Frame Size)
Resolution is the number of pixels that can fit inside the video frame. It is usually presented as "width x height" of the frame,
for example, 1280x720 or 1920x1080. Sometimes, resolutions may also be referred to as "720p" or "1080p", by the number
of pixels in a frame vertically. At high resolutions, each frame is conveyed using more pixels, therefore allowing for more
detail and higher quality, though taking up more disc space. Whenever you convert a video to a lower resolution, you
irretrievably lose some data, but if you convert a low-resolution video to HD, the quality will stay the same. If you need to
do so, however, we recommend that you use Upscale SD, DVD to HD presets in Movavi Video Converter, as they use an
algorythm that slightly improves video quality when converting to larger resolutions.
 
Sample Rate
Sample rate, measured in Hertz, determines how many samples of digital audio are recorded each second. Higher sample
rates allow to record higher quality audio, although the files will take up slightly more space. The recommended sample rate
is 44100 Hz, which is the standard for audio CDs, delivering sound that covers the full range of human hearing. To reduce
file size, you can convert audio with lower sample rates, as low as 22 kHz, but keep in mind the quality deterioration. 
 
Subtitles
A subtitle is text that appears on screen (usually at the bottom) that reproduces the video's dialogue or presents additional
explanatory text and sound effects. Subtitles are frequently used by people hard of hearing, language learners, and when
an audio translation is unavailable. The subtitles may be embedded within the video container file (also known as softsub),
saved as a separate file in *.srt, *.ass, *.sub, and other subtitle formats, or drawn over the video stream in such a way that
they cannot be disabled (hardsub).
 
Video Formats
Audio Video Interleaved – AVI (*.avi)
AVI is a multimedia container format created by Microsoft in the early 1990s. AVI supports multiple video and audio codecs
and can contain up to 16 audio and 16 subtitle tracks. While support for AVI is widespread on all operating systems, it is
steadily being replaced by more efficient formats.
 
DivX (*.divx)
DivX is a proprietary video format developed by DivX, Inc. Using its own codec, DivX allows for high compression rates while
retaining high quality. Sometimes the DivX codec is also used to encode video in AVI files. DivX is not supported by many
media players, and requires a codec pack to play. Movavi Video Editor can open DivX files, while Movavi Video Converter
can open and convert DivX files to any other format.
 
Flash Video Format – FLV (*.flv)
Developed by Macromedia and currently owned by Adobe, FLV is frequently used for web video, as it is supported by most
web browsers and is accepted by most video sharing services and social networks. FLV can contain video encoded in
Sorenson, FLV1, VP6 and H.264 codecs.
 
QuickTime – MOV (*.mov)
Developed by Apple, QuickTime is natively supported on Macs and iOS devices, so if you need to be sure that your video
can be played on a Mac, converting it to MOV would be a good idea. If you are preparing your files to also be played on
a Windows computer, it's best to convert it to MP4, as Windows computers need to download and install QuickTime from
Apple's official website in order to play MOV videos.
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SWF (*.swf)
Developed by Macromedia and currently owned by Adobe, SWF (formerly Shockwave Flash) is a video and graphics format
related to Flash video that can cointain video, animations, vector images, and other content. Usually created in proprietary
Adobe software, SWF files are supported by Adobe Flash Player and most web browsers, which makes it an efficient way of
sharing content online due to the small file size.
 
WebM
WebM is a free open-source container format developed by Google. It primarily functions as a widespread web video format
that can easily be embedded in HTML5 video tags. WebM can contain video encoded in the free VP8 and VP9 video codecs
and Vorbis audio.
 
Movavi File Formats
*.mep, *.mep2
Used in Movavi Video Editor to create editing projects that store file references, order of files on the timeline, applied effects,
and all other work on the project.
 
*.mscproj, *.mrec
Used in Movavi Screen Capture and Movavi Screen Capture Studio to store temporary recording data, including the
recording itself, as well as all settings used for the project.
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